In addition to the items mentioned above, Sensor positioning
accessories and wall-, apron- and instrument-mounting kits are
available for the Schick WiFi system. To expedite the pairing between
the Schick WiFi Interface and the PC workstation, an RFID reader is
also available. Accessories are described separately in this document.

An illustration of the Schick Wili system is shown in Figure 1.

PC Workstation

Wireless Interface - : =
it | ===
\ . ::::::;___;_/’ h gml !Fh
A\ ). P :_jﬂ‘gl\_ 5 '%- 5
g cooo  IEEE 80211 .r/ % -
o =] e ) N[ A [
P |
-
- loge| £
A~ -
— |
Schick WiFi Iy
Interface

Schick WiFi Docking Station

Figure 1. Schick WiFi System Connections?

The Schick WiFi Interface and Schick WiFi Docking Station also
provide additional functions and are described in the following pages
of this section.

The Schick WiFi system acquires X-ray images and transmits them to
the PC workstation through an 802.11 b/g compliant WiFi access
point. Temporary memory storage in the Schick WiFi Interface
enables images to be retransmitted, potentially recovering from
severe interferences that may occur while the Schick WiFi Interface
and sensor are in use.

2 Schick WiFi system illustration © 2013 Sirona Dental Systems GmbH
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1.6. Accessories

Schick WiFi is available with a range of accessories that aid the
clinical user in the proper use and storage product.

e Schick AimRight Holder System — designed to mount to the
WiFi interface for easy positioning and patient comfort, Schick
AimRight is available in autoclavable form for multiple uses or
in Adhesive form for maximum flexibility and comfort. Schick
AimRight offers simple, repeatable parallel positioning for
optimal diagnostics.

e Mounting options — enables the user to clip the Schick WiFi
Interface to the patient’s radiation shield or mount it to the
delivery system while in use. When not in use, Schick WiFi can
be stored in the Docking Station and the Sensor is provided
with its own wall mount for safe and secure storage.

1.7. Sensor Holders and Sheaths

New holder sets (part of the Schick AimRight positioning system)
were produced for the Schick WiFi system to accommodate the
unique design of the Schick Wili Interface and to help ensure that
your image acquisition setup and workflow are optimal.

Table 1 describes the placement and use of the AimRight system for
various anatomical regions.

Sheaths and the appropriate holders are required for Schick Sensors.
Sheaths provide cross-contamination protection via custom-designed
sheaths to minimize the risk of the Sensor being contaminated while
in the oral cavity. Sensors must be cleaned before using they are used the first
time and before every new patient (refer to Section 6.2). Sensor holders, if
disposable, are also required for each new patient and must be
disposed of propertly after patient use.

Table 2 and Table 3 describe the correct procedures for removing the
sheath from the Sensor, with and without a Sensor holder attached.

Two designs are available: a grip-style and an adhesive-style, enabling
customers to select a holder style that best fits their own Sensor
positioning routines and preferences. Compatible with all sizes of the
Schick Sensor, the holder sets are appropriate for Schick WikFi and
Schick USB systems. More information about Schick holder sets is
available from our website at www.schickbysirona.com.
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Table 1. Sensor Positioning (AimRight Grip System)

EXAMPLES

PLACEMENT INSTRUCTIONS

Maxillary Anterior

Place the distal end of the sensor against the
roof of the mouth, with the incisal edge of
the teeth against the front of the tab.

Sensor should be parallel to the long axis of
the maxillary anterior teeth. Ensure the ring
is as close to the patient’s face as possible
and place the x-ray head against the ring.

Mandibular Anterior

Place the Sensor into the lower anterior atrea,
positioning it on top of the tongue, parallel
to the first molar.

Sensor should be centered on the
mandibular anterior teeth when the patient is
occluded. Ensure the ring is as close to the
patient’s face as possible and place the x-ray
head against the ring.

Horizontal Bitewing

Place the Sensor between the tongue and the
teeth with the bite area resting on the
premolar teeth.

The patient should close on their back teeth
to ensure centric occlusion and as they do
so, the arm should be angled gently toward
the midline of the mouth to ensure the
Sensor is parallel with the teeth and to
provide open contacts. Ensure the ring is as
close to the patient’s face as possible and
place the x-ray head against the ring.

Schick WiFi User Guide
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EXAMPLES PLACEMENT INSTRUCTIONS

Vertical Bitewing

The sensor should enter the mouth
horizontally. Once past the incisors, “roll”
it into a vertical position.

Sensor should be placed with the cable
pointing upwards toward the hard palate.
Ensure the ring is as close to the patient’s
face as possible and place the x-ray head
against the ring.

Mandibular Periapical

Retract the cheek with a finger and place the
sensor between the tongue and the teeth,
bringing the cheek around the bite block.

Slide the sensor down and in gently until it is
in position—the bite tab should be directly
above the teeth tobe imaged. Ensure the ring
is as close to the patient’s face as possible
and place the x-ray head against the ring.

Macxillary Posterior

The Sensor/aiming device is angled upward
toward the midline with placement of the
bite block under the teeth to be captured.

The Sensor should be angled slightly past the
midline of the palate as the patient closes for
comfort and to ensure capture of the apices.
Ensure the ring is as close to the patient’s
face as possible and place the x-ray head
against the ring.

NOTES:

When using the Aim Right grip system, always insert the Sensor by aligning one end and then “snapping”
the Sensor into place. Refrain from sliding the Sensor into the grip holder.

Additional information regarding Sensor positioning can be found in the Schick AimRight Positioning
System Guide, available from the schickbysirona.com website.
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Table 2. Proper Sensor Removal from Sheath (AimRight Autoclavable System)

ACTIONS

EXAMPLES

A\
' 1. Begin by pinching the distal end of the

Sensor out of the sheath.

|I t_ 'I"I

\ 2. As the Sensor is pushed into the wider
E J area of the sheath, gently slide the sheath
" away from the Sensor.

[l
il
|
ll.. 3. Be careful to prevent the Sensor from
falling on the floor.

NOTE: Additional information regarding Sensor usage can be found in the Sensor Care Guide, available

from the schickbysirona.com website.
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Table 3. Proper Sensor Removal from Sheath (AimRight Adhesive System)

EXAMPLES

ACTIONS
-
1. Keeping the Sensor attached to the
l positioning tab, grasp the aiming bar
"’ }.l where it joins the Sensor and begin
pushing the distal end of the Sensor out
\ [ of the sheath.

2. As the Sensor is pushed into the wider

area of the sheath, gently slide the sheath
away from the Sensor.

3. Be careful to prevent the Sensor from

P, .e.';f falling on the floor.

NOTE: Additional information regarding Sensor usage can be found in the Sensor Care Guide, available
from the schickbysirona.com website.
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1.8. PC Workstation

The PC workstation (CE-approved computer system conforming to
the Low Voltage [73/23/EC] and EMC Directive [89/336/ERC])
connects to the USB Interface of the Schick WiFi Docking Station
via a compatible USB cable (Part number B2250151) and serves as
the host for imaging software and utilities. For safety, connect the
cable from the USB Interface to Listed / Approved / Certified
Information Technology Equipment (ITE) computer equipment
only. The workstation provides the capabilities to display, manipulate,
store, and print images acquired with Schick Wili hardware.

Recommended system requirements for the PC workstation are listed
below. (For the latest information, please refer to the system requirements page
on our website.)

e Windows 8 and Windows 8 x64, and Windows 7 (Howze Preminm,
Professional, Ultimate) and Windows 7 x64.

e CDR DICOM for Windows 5 and higher. (EagleSoft and
Patterson Imaging software versions to be determined.) Please
visit our website, or contact support for Sirona Dental products
in your area or region. In the United States, customers can
contact the Patterson Technology Center at 877-498-6505.

e Intel i7 or equivalent
e 8 GBRAM

e 1 TB hard drive (practice-specific, depends on number of
patients)

e Intel USB 2.0 or 3.0.

When connecting the Docking Station via USB cable to the PC
workstation, we recommend the use of a 2 meter (6.6 feet) USB cable
— supplied with the Schick WiFi system — and having the following
specification: 28 AWG/2C and 20 AWG/2C with the “/2c¢”
designation marked along the cable, typically at either end and close
to the connector. The “/2¢” designation is the USB spec designation
for power connectors inside the cable, and is a requirement for this
system.

Schick WiFi User Guide
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1.9. Software

CDR Dicom is one of the imaging applications that can provide the
software interface between the Schick Wili system hardware and the
computer (other compatible imaging programs include EagleSoft and Patterson
Imaging). CDR provides the customer with advanced features for
acquisition, display, manipulation, storage, and printing of acquired
X-ray images. Please refer to the CDR DICOM User Guide, available
on our website, www.schickbysirona.com, for more details.

Several software utilities specific to the Schick WiFi system have been
developed to assist with product configuration, monitoring, and
diagnosis. These include the following:

e Wireless Monitor
(Section 1.9.1 on page 13)

e Wili Configuration Ultility
(Section 1.9.2 on page 15)

e Web Server and Upgrade Ultility
(Section 1.9.3 on page 10).

PLEASE NOTE: When released officially, software updates are available from
the Schick Wik product page on our website. In some cases, features described
in this user guide may be found in software that is currently pending release.
These features will be noted as such in text.
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1.9.1. Wireless Monitor

The Wireless Monitor is included with Schick WiFi software and is
installed automatically. When the workstation is turned on, the
Wireless Monitor initializes automatically and remains active until the
workstation is turned off.

A sample screen of the Wireless Monitor is shown below.

|V WFi Interface Status
| v WiFi Interface Management
Exit

F o
o 1

-

The Wireless Monitor menu items are described below:

e Schick WiFi Interface Status: Reports the battery level to
its currently paired workstation and the signal strength
relative to the wireless access point. When paired, Schick
WiFi Interface names will be displayed. When connected,
Sensor serial numbers will be shown.

Ir‘|.|'|.|'iFi Interface Sta'lus‘ ﬂ1
File Options
Paired Interface: Battery Level:
Sensor 5/n: Signal Strength:

(= —

e Schick WiFi Interface Management: Lists all detected
Schick WiF1 Interfaces, their name, signal strength,
battery level, and the Sensor and workstation where they
are connected.

e Exit: Closes the Wireless Monitor and removes it from
the Windows System Tray. Exiting the Wireless Monitor
also unpairs any Schick WiFi Interface paired to that
workstation.

A sample screen of the Schick WiFi Interface Status window is
shown below. Other examples are described in Table 10 on page 57.

Sample screens of the WiFi Interface Management window are
shown below.

Schick WiFi User Guide
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File Options

Workstation name: Left16Windows

Currently Paired WiFi Interface: Mo Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name | Signal | Battery ‘ Sensor | Status | Paired PC |
25cott217z Excellent 100 In Charger Available
P234567 Excellent 100 In Chargel Paired LeftVista64-Only
— —
% WiFi Interface Management [
File Options

Workstation name: LeftVistac4

Currently Paired WiFi Interface: P234567

Detected WiFi Interfaces:

Interface Name | Signal | Battery Sensor Status | Paired PC
2217z Excellent 100 In Charger Available
P234567 Excellent 100 In Charger Paired LeftVista64-Only

Detected devices display in different font styles in the WiFi Interface
Management window. This is done intentionally to provide a quick
snapshot of the Schick WiFi system. In fact, the way the Schick WiFi
Interfaces appear in the window provides status information about

them.

e If the Schick WiFi Interface appears in bold type, it is paired to
the current workstation.

e If the Schick WiFi Interface appears in gray type, it is paired to a
different workstation.

e If the Schick WiFi Interface appears in regular type, it is
unpaired.

e If the Schick WiFi Interface has the words “-Only” in the Paired
PC column, it is paired exclusively with the workstation listed.

A Schick WiFi Interface can only be paired to one workstation at a
time. You cannot pair to a Schick Wik Interface if it is already paired
to a different workstation.

Schick WiFi Interface pairing, as a term to describe how Schick WiFi
Interfaces and workstations connect to transfer images wirelessly, is
discussed in more detail in Section 3 on page 41.

14
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1.9.2. WiFi Configuration Utility

The Wilki Configuration Ultility enables customers to configure the
Schick WiFi Interface to communicate with their wireless network.
Configuring the Schick WiFi Interface is necessary before using it
with imaging applications but this action is needed only when setting
up the Schick Wil system initially or if the wireless network changes
in any way.

A sample screen of the WiFi Configuration Utility is shown below.
For additional information and instructions regarding the utility,
please refer to Section 3 on page 41.

P

-+ WiFi Configuration Utility

File Tools Help
Wifi Interface Serial Number:
Wifi Interface Friendly Name:
WiFi Interface Region Setting:

Available Networks

P234567
LisasOp

United 5tates v|
Refresh |

MName
‘,’f’ TestRack
1" Zoom
1" MNETGEAR:PAT TEST
1" development
1" corp2test
1 visitor
Currently Configured Network
Mare: TestRack
IP Address: 172.16.1.102
IP Assignment:  Dynamic (DHCP)
MAC Address:  00:0B:5C:B4:2D:5E

g

Status: Ready

Security Signal  Channel
WPA/WPAZ = 1 =
WPA/WPAZ = 10
WPA/WPAZ = 1
WPA/WPAZ = 1
WPA Enterprise = 6
WPA/WPAZ = & M

Connect |

Connection status J

IP Address status J

Discovery Method: | SSDP '|

Schick WiFi User Guide
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1.9.3. Web Server and Upgrade Utility

The Web Server and Upgrade Ultility enables wireless upgrades of
firmware or other files in either the Schick Sensor or the Schick WiFi
Interface, provides updates, including new features, and can be used
for system status and diagnostic purposes.

The Web Server and Upgrade Utility performs the following:

e Displays Schick WilFi Interface and Sensor status
information.

e Upgrades firmware in the Schick WiFi Interface
wirelessly. Although not required, we recommend that the
Schick WiFi1 Interface be in the Docking Station
(“docked”). Flash and FPGA upgrades can be performed with
the device ontside the Docking Station, but the battery charge must
be 50% or higher to ensure there is no interruption to power during
the upgrade process.

e Upgrades firmware in the Schick Sensor wirelessly. The
Schick WiFi1 Interface must be outside the Docking
Station (“undocked”) and the Schick Sensor must be
connected to the Schick WiFi Interface.

e Performs tests for Speed, Hardware, and Sensors as
described in Section 5.3 on page 102.

e Provides user-configurable settings.

For sample images, refer to the figures on the pages that follow. For
procedures, skip ahead to Section 5, starting on page 86.

16
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Web Server and Upgrade Utility

Status

©3.90.192

Firmware Upgrade

This window displays status and device information.

— Schick WiFi Interface Version

Diagnostic Settings

— Schick WiFi Interface Serial Number

20001859

2.6 / 2.0

—Sensor Version (firmware / hardware)

12015592

—Sensor Serial Number

Copyright (c) Sirona Dental, Inc.

Figure 4. Schick Wiki Status Tab

Firmware Upgrades
Clase your imaging program and make sure all hardware is connected.

Web Server and Upgrade Utility

Diagnostic Settings

FPGA

Current version:
©3.00.192

Choose File | No file chosen

Ve

Choose File | No file chosen

Current version (firmware / hardware):

ensor

et

Current version:

No file chosen

Progress: 0%

To upgrade, browse the file and click the Submit button.

Figure 5. Schick WiFi Firmware Upgrades Tab

Schick WiFi User Guide
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Web Server and Upgrade Utility

Status ware upgrades -

Diagnostic
Clase your imaging program and make sure all hardware is connected.

—Speed Test —Hardware Test

This is a bandwidth test to measure how fast

N This is a test to check the status of your connected devices,
an image can be transferred.

Please make sure that the WiFi Interface and Sensor are

connected.
Click on the button to start speed test.

WiFi Interface connection J

WiFi Interface to Sensor
connection

4\

Sensor Test Sensor Voltage is Normal J N
Sensor connection
Sensor Firmware is Verified J

{

Figure 6. Schick Wiki Diagnostic Tab

Web Server and Upgrade Utility
Status Firmware Upgrade agnastic
Settings
Schick WiFi Interface Friendly Name: arWiFil
WiFi Interface Battery: Schick

Power OFF Timeout (minutes):

[ Enable Sleep Timeout

Sleep Timeout (minutes):

[J Enable Auto Pairing

1

Automatically pair with work

Save

Restore factory defaults:

Figure 7. Schick WiFi Settings Tab

18
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2. Installation

2.1. Install WiFi Configuration Utility

PLEASE NOTE: You will only need to perform the following steps on the PC being used
to configure the Schick WiFi Interface for your wireless network.

STteEP 1

Insert the Schick WiFi CD into your CD-ROM
or DVD drive. The Schick Wiki Start page
should display automatically. If it does not,
browse the CD and double-click on Setup.exe.

If you do not have the CD, you can download
the latest driver from the Schick WikFi Support
area on our website.

STEP 2

Click Install WiFi Configuration Utility.

English Frangais Espaiiol Svenska

Schick WiFi Installation

& Schick WiFi Installation

Introduction
©On this page you will b abie ta install the software for your Schick WiFi system

c ibility and

Your aperating system: Micrase®t Windows T Profossianal SP 1 (54-it)

Bafeea instaling this software, make sure that you have one of the following suppored oparating systems:

uuuuuu

To get started, refer Lo the mstr

ELLLEELY
wInstall on Any PC
.

Install Wii Configuration Utility

Install on PC(s) for Wireless Imaging
Install Schick WiFi Sofware

Schick WiFi User Guide B1051080 Rev. 4
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STEP 3

If prompted, install the NET Framework.

prerequisite programs may be required.
For a successful installation, allow these
prerequisites to install until complete.

NOTE: Depending on your system, other

STEP 4

- WiFi Configuration Utility Setup

For the following components:

_MET Framework 35 SP1

Pleasz read the following licenss agreement, Press the page down key to
see the rest of the agreemert

1>

MICROSOFT SOFTWARE
SUPPLEMENTAL LICENSE TERMS

MICROSOFT .NET FRAMEWORK 3.55P1
FOR MICROSOFT WINDOWS OPFRATING ¥

[ | View EULA for piinting

Do you accept the terms of the pending License Agreement?

1F you choose Dion't Accept, instal will close. To installyou must accept
this agieement

Click Next at the Welcome screen.

STEP 5

- .
| 5] WiFi Configuration m_ [ )

Welcome to the WiFi Configuration Utility Setup {
Wizard SN
=

The installer will guide you thiough the steps required to install WiFi Configuration Utility on your
commpuber.

I WARNIMG: This computer program is pratected by capyright law and international treaties.
Unauthorized duplication or distribution of this program. or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Click Next at the Select Installation Folder

i B
o
screen.
Select Installation Folder
The installer will install wiFi Configuration Utility ta the following folder !
To installin this folder. click “Mext". Ta install to a different folder, enter it below or click "Browse".
FEolder:
IC:\F‘rogram Files [«861\Schick. TechnalogieshS chick Wikt Biowse.
'
Cancel ] [ < Back ] [ Mext » ]
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STEP 6

Click Next at the Confirm Installation screen. (1 wecortauaien v D o

|| Confirm Installation

The installer iz ready to install 'iFi Configuration Utility on your computer.

Click "Next" to start the installation,

Cancel ] [ < Back ] ' Mext > I

STEP 7

Click Close when installation is complete.

o -

|| Installation Complete

WiFi Configuration Utility has been successiully installed.

Click "Cloge" to exit.

Please use Windows Update to check for any ciitical updates to the MET Framework.

Cancel | | < Back | ' LCloze I
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2.2 Install Wireless Software

your wireless network.

PLEASE NOTE: Perform the following steps on the PC(s) being used for imaging on

SteP 1

Click Install Wireless Software on the Schick
Wikt Start page or browse the CD (if you are
installing from disk) and double-click on Schick
Wik Setup.exe.

Esglish  Francais  Espadol  Svemska

Schick WiFi Installation

NOTE: Depending on your system, other
prerequisite programs may be required.
For a successful installation, allow these
prerequisites to install until complete.

STEP 2

O this page you will ba abls 1 install the softwace for your Schick WiFi system

and
Your aperaling system: Microsoh Windows 7 Professsonal ISP 1 {Bi-bat)
Befors instaling this software. make sure that you hiv one of the follawing supparted aparating systems

+ Windows § and Windows § x64
« Windows 7 and Windows 7 x64 (Home Premium, Profassional, Uitimate)

To got stated. refer to the instructions for complete installation details

Install on Any PC

Install Wii Configuration Uity

E NN NN NN NN EEEEEEEEEEEEEEES,
:Inllxll on PC(s) for Wireless Imaging

o Install Schick WiFi Sofware

EEEEEssEEEEEEnnnn
al, o All Righs Reserved

Click Next at the Welcome screen.

-
1) Schick WiFi Driver - InstallShield vaan- |
I

Welcome to the InstallShield Wizard for Schick
'WiFi Driver

The InstallShield(R) Wizard will install Schick WiFi Driver on your
computer, To continue, dick Mext.

WARNIMG: This program is protected by copyright law and
international treaties.

22 B1051080 Rev. 4 Schick WiFi User Guide



STEP 3

Click Install at the Ready to Install screen.

STEP 4

Schick WiFi Driver -

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Instalishield

<gack |{ pmswil§ [ cancel

A. Click Finish.

B. Close the Schick Wik start page.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Schick WiFi
Driver. Click Finish to exit the wizard.
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2.3. Connect the Docking Station

STEP 1

A. Connect power supply cable to the Schick
WiFi Docking Station.

B. Connect power supply adapter to a wall
outlet in the operatory.

STEP 2

A. Open the compartment on the Docking
Station and connect the USB cable to the
Docking Station and to the PC
workstation with the WiFi Configuration
Utility installed.

B. Several drivers install automatically.
At the end of the installation, the
message, “Your device is ready for use”
appears momentarily.
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2.4. Configure the Schick WiFi Interface for your
Wireless Network

PLEASE NOTE: Your Schick WiFi system will operate with wireless routers and access
points from many well-known manufacturers. In the event you experience a wireless
network-related issue during installation, please consult the documentation supplied with
your router or access point for details and additional information.

STEP 1

Insert the Schick WiFi Interface into the
Docking Station and wait about 15 seconds for
the Schick Wili Interface LED to start flashing.

Notes:

If the Schick WiEi Interface is switched off, it will turn
on and the LED light will display a blue-purple color
(shown in Figure 11 on page 43) when inserted into the
Docking Station. Please wait 15 seconds for boot-up to
complete; at that point, the LED will begin to flash,
indicating the current battery level.

If you are using the Schick Wiki Interface for the first
time and notice that the 1.LED indicates a low battery
charge (orange-to-red color range), the Schick Wiki
Interface will need to be charged in the Docking Station.

To recharge fully, the Schick Wik'i Interface may require
up to 2 hours of charging. For confignration purposes,
however, it is acceptable to continue with this procedure.

Schick WiFi User Guide B1051080 Rev. 4
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STEP 2

Start the Wili Configuration Utlity (Windows
Start > Programs > Sirona Dental > Schick
Wik > WiFi Configuration Utlity).

STEP 3

Wifi Interface Friendly Name:
WiFi Interface Region Setting:

Available Networks

. WiFi Configuration Utility = | G |
B i

File Tocls Help

Wifi Interface Serial Number: P234567

LisasOp

MName

i Test Rack
1" Picostation
7' Zoom

1 Exec

Security Signal  Channel
WPA/WPAZ = 11 =
WPAAWPAZ = 1
WPA/WPAZ ol 10
WPAMWPAZ = 6

Currently Configured Network

Name: TestRack
1P Address:
1P Assignment:  Dynamic (DHCP)

MAC Address:  00:0B:5C:B4:2D:5E

Status: Ready

Connection status

IP Address status

Discovery Method: |SSDP =

A. Select your wireless network from the
Available Networks window.

PLEASE NOTE: A hidden wireless
network that does not broadcast its name
or SSID might not appear on the list of
available networks. In this case, you will
need to follow the steps to create a new
network (File > Create a new network)
and connect to it using the hidden
network’s SSID, password, and security.

B. Press Connect.

Wifi Interface Friendly Name:
WiFi Interface Region Setting:

Available Networks

- WiFi Configuration Utility SRECN X
B i

File Tocls Help

Wifi Interface Serial Number: P234567

Op

MName

i’ Test Rack
1" Picostation
T Zoom

1 Exec

Security Signal  Channel
WPA/WPAZ = 11 =
WPAAWPAZ = 1
WPA/WPAZ = 10
WPAMWPAZ = 6

Currently Configured Network

Name: TestRack
IP Address:
IP Assignment:  Dynamic (DHCP)

MAC Address:  00:0B:6C:B4:2D:5E

Status: Ready

g uwew
Connection status X
IP Address status X
Discovery Method: |SSDP =

Fasuy '
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STEP 4

If connecting to a secure network, enter the

-+ WiFi Configuration Utility

network password and click Connect (or press
File Tools Help
the Enter key). Wifi Interface Serial Number: P002452
Wifi Interface Friendlv Name: BAT-NewBattery
[=]
WiFi Interfag| ¢ connect Nework = States ~
Connect to new network
Available Ne | - TestRack Refresh
. Channel -
o || Mode: " Access Point
1" marconi-4)| 1
o man:on|'+| Security: WPA/WPAZ? [1
“{" NETGEAR| | Password:  [eeseeesessense 11
1" Zoom IP Address Configuration 10
“1" sirONAC| Method: Dynamic [DHCR) || 6
“1”_SIRONARI 6 -
Mame: | '(
1P Address: | -(
IP Assignment: | Connect I [ Cancel ] T: [SSDP ']
MAC Address:  TOUDBBCCFOTES
Status: Ready I
STEPS
A progress bar is displayed as the Schick Wikl —— — =
) . WiFi Ccnﬁgura:on Utility —
Interface is configured for the network. Fle. Tools_Help
Wifi Interface Serial Number: P234567
Wifi Interface Friendly Name: LisasOp
WiFi Interface Region Setting: United States | +
|| Available Networks Refresh
MName Security Signal  Channel -
G Test Rack WPA/WPAZ = 11 =
f "‘T\J Picostation WPA/WPAZ = 1
Wl ‘7" Zoom WPA/WPAZ = 10 fl
||
17 Exec WPA/WPAZ = 6

Currently Configured Network
Name: TestRack

IP Address:

IP Assignment:  Dynamic (DHCP)

MAC Address:  00:0B:6C:B4:2D:5E

Status: Ready

Connection status x

IP Address status x

Discovery Method: | SSDP *
Wiaiting to connect... Stop waiting I

Schick WiFi User Guide B1051080 Rev. 4
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STEP 6

When configuration is complete, Connection
status and IP address status are indicated by

green checkmarks and the Status is shown as
Ready.

STEP 7

£ WiFi Configuration Utilty L-E‘ﬂlg
Eile Tools Help
Wifi Interface Serial Number: P234567
LisasO

| ‘Wifi Interface Friendly Name:
‘WiFi Interface Region Setting:

! Available Networks

i MName Security Signal Channel
|| ' Test Rack WPA/WPAZ = 1 2
‘1" Picostation WPA/WPA2 = 1 —
‘1" Zoom WPAMWPA2 = 10
=" WPAWPAZ = 6
-
Currently Configured Network | Connect |

Name: TestRack
1P Address: 172161113

IP Assignment:  Dynamic (DHCP)
MAC Address:  00:0B:6C:B4:2D:5E

Status: Ready

Connection status (
IP Address status (

Discovery Method:

A. Remove the Schick WiFi Interface.

B. Close the Wilfi Configuration Utility.
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STEP 8

A. Disconnect the USB cable from the
Docking Station.

B. Launch the Wireless Monitor by either
starting CDR DICOM (which opens the
monitor automatically), or by clicking on
Windows Start > Programs > Startup >
Wireless Monitor.

C. If a Windows Firewall message appears,
click Unblock.
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2.5. Pair the Schick WiFi Interface with the PC

Workstation (Software Option)

PLEASE NOTE: If you are using the RFID option, which is using the RFID Reader for
pairing, please skip the following steps and continue with Section 2.6.

NOTES

Make sure that the Schick WiFi Interface is ON
and its LED is flashing.

If the Schick Wili Interface is OFF (LED not
flashing), press the Schick WiFi Interface button
to turn it on, then wait about 15 seconds as the
Schick WiFi Interface boots up (LED is solid
purple) and begins flashing (ILED color depends on
the battery charge).

STEP 1

Click on the Wireless Monitor icon located in
the Windows System Tray and select Schick
Wik Interface Management.

WiFi Interface Status

WiFi Interface Management
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STEP 2

Click the Schick WiFi Interface to be paired,
based on its serial number, as listed in the WiFi
Interface Management (I7 may take 25 seconds for
the Schick Wik Interface to appear on the list after it is
turned on.) The Schick WiFi Interface must be

“Available” for pairing.

File Options

Waorkstation name: w7

Detected WiFi Interfaces:

Currently Paired WiFi Interface:

No Paired WiFi Interface

Pair

Interface Name I Signal Battery | Sensor I Status I Paired PC
POD2577 Excellent 100 In Charger Paired englabw?
000BSCCCFBCC Excellent 101 Available
P121212 Excellent 101 Available
PO00217 Excellent 100 In Charger Available

STEP 3

Right-click on the Schick Wili Interface you
wish to pair and select “Pair”. Alternatively, you
can click the Pair button or double-click on the
particular Schick WikFi Interface to be paired.

File Options

Workstation name: w7

Detected WiFi Interfaces:

Currently Paired WiFi Interface:

Mo Paired WiFi Interface

Open Device Web Interface

Interface Mame | Signal | Battery | Sensor | Status | Paired PC
POO2677 Excellent 100 In Charger Paired englabw?
000B&CCCFBCT Excellent 101 Available
P121212 Excellent 101 Available
PO00217 Excellent 100 In Charger Available

Pair

Schick WiFi User Guide
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STEP 4

When the Schick Wiki Interface pairing message
displays, press the Schick Wik Interface button
to confirm the pairing.

ready to be paired.

pushbutton

The WiFi Interface PO00217 has been selected and is

The LED on this device stays constant until you press the

Cancel

STEP 5

The Wil Interface Management window will
indicate that the Schick WiFi Interface is paired.

File Options

Waorkstation name: w7

Currently Paired WiFi Interface: POOD217 Unpair
Detected WiFi Interfaces:

Interface Name I Signal Battery | Sensor I Status I Paired PC I

POD2577 Excellent 100 In Charger Paired englabw?

000BECCCFBCC Excellent 101 Available

P121212 Excellent 101 Available

POOD217 Excellent 100 In Charger Paired w7

PO00230 Fair 100 In Charger Available
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2.6. Pair the Schick WiFi Interface with the PC

Workstation (RFID Option)

NOTES

Make sure that the Schick WiFi Interface is ON
and its LED is flashing.

If the Schick WiFi Interface is OFF (LED not
flashing), press the Schick WiFi Interface button
to turn it on, then wait about 15 seconds as the
Schick WiFi Interface boots up (LED is solid
purple) and begins flashing (ILED color depends on
the battery charge).

SteP 1

Click on the Witeless Monitor icon located in
the Windows System Tray and select Wiki
Interface Management.

Make sure that the Schick WiFi Interface is
listed in the WilFi Interface Management
window.

STEP 2

|v WiFi Interface Status
| WiFi Interface Management

Connect the RFID reader to an easily accessible
USB port; one where you can also see the
computer monitor screen (for example, a USB port
on the side of the monitor. The monitor must connect by
USB cable to the PC workstation. If a convenient USB
port is not available, a USB extension cable is supplied
to allow the REID reader to be placed in another
convenient location: on a connter top for instance).

The driver for the RFID reader will install
automatically and a message confirming that the
device is available for use will appear after a few
seconds.

Schick WiFi User Guide B1051080 Rev. 4
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STEP 3

Touch the RFID reader with the Schick WikFi
Interface and make sure that the wireless symbol
near the ON/OFF button comes vety close to,
or makes contact, with the RFID reader.

STEP 4

A momentary message displays above the
System Tray, “Tag Read completed”. The Wiki
Interface Management window will indicate that
the Schick Wiki Interface is paired to the
current workstation.

. WiFi Interface Managen
File Options
Waorkstation name: w7
Currently Paired WiFi Interface: POOD217 Unpair
Detected WiFi Interfaces:
Interface Name I Signal Battery | Sensor I Status I Paired PC I
PO0D2577 Excellent 100 In Charger Paired englabw7
000BECCCFBCC Excellent 101 Available
P121212 Excellent 101 Available
PODD217 Excellent 100 In Charger Paired wl
PO0DO230 Fair 100 In Charger Available
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2.7. Start CDR, Connect the Sensor, and Prepare for Use

STEP 1

A. Start your dental imaging software (in this
example, CDR DICOM). ’7
b

B. In the CDR Exam window, click File > SCh’%\J .

New, or click the New Exam button. In Pl
the Patient Information dialog box, enter |
the appropriate information and select the |~ -
. e . CDR DICOM for Windows
SEries. ; Computed Dental Radiography
Version 5.11.1838.9048
Sitvatuc e
C Cljck OK Loading CDRVideo module..
STEP 2

A. Connect the Schick sensor to the Schick
WiFi Interface.

B. Check the X-ray exposure settings. The
proper settings depend on several factors,
among them, the X-ray source itself, the
anatomy of the patient, and the location
of the Sensor in the oral cavity

C. Place the Sensor in a positioning holder,
and then place the sheath over the Sensor
and holder. Place the Sensor in the
patient’s mouth with the flat side facing
the X-ray source.

STEP 3

A. If you are using the Sensor for the first
time on this workstation, the calibration
file will install automatically. If the
calibration file does not download
properly, disconnect the Sensor and re-
connect it.

B. The first empty view box is pre-selected
and flashes green (default setting).
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STEP 4

A. Activate the X-ray source. “Reading
Image from Sensor” appears on the
screen momentarily.

B. When acquisition is complete, the image
is displayed in the software. Depending
on the settings selected under CDR
Options, the image will appear either in
the Exam or Zoom window.

C. To take another image, reposition the
Sensor and repeat the steps for image

acquisition.

D. Customers with other imaging software,

such as EagleSoft and Patterson Imaging,

should consult their documentation for
steps on acquiring images.

7 WAFS_New, WiF Hew
e
[T T 8 - =7 & .0

| e Owen  Clum  Moss Wil BeiSel el Quolesn Sme  Filfmen  Thhogs  Cndw 5

Image Information
Ties,
Halaz
nate

Exam Information
wLRen Dale T

a0 P
5t

EEE

VCRIZONTAL LS| DES | CRIZGNTAL I3
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2.8. Installing Storage Holsters, Mounts, and Clips

Several items are available with the Schick WiFi system to protect the
devices from accidental damage and to keep them easily accessible.
To install these items, please refer to the appropriate sections that
follow.

2.8.1. Sensor Holster Installation

Sensor holsters are a convenient way to keep your
Sensors easily accessible and safe from accidental
damage and misuse. The Sensor holster can be
installed using either an adhesive pad or a flat-head
Phillips screw (3/16-20 x 1) and anchor (supplied).

Please Note: When locating the holster, allow enough distance from
the floor to accommodate the relaxed coils of the Sensor cable.

For the adhesive pad option, perform the following steps:

e Prepare the surface by cleaning it and allowing it to dry
completely if you have applied a liquid solution. The pad
is adhesive on both sides, and has protective layers on
both ends.

e Remove one layer and apply it to the back of the Sensor
holster. Remove the other layer and press firmly onto the
surface where the holster will be located.

For an alternate option, perform the following steps:

e DPosition the Sensor holster on a smooth, stable, vertical
surface.

e Drill a hole the same size as the anchor supplied; then,
push the anchor completely into the drilled opening.

e Using the hole on the back of the holster as a guide,
insert the screw through the holder and fasten it securely
to the anchor and the wall.
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2.8.2. Docking Station Mount Installation

Wall mounts (Part number B2420135) for the
& Jfo' - Docking Station also provide accessibility and
y 2> protection. The mount can be installed using either

\f/ an adhesive pad or two flat-head Phillips screws and
anchors (supplied).

For the adhesive pad option, perform the following steps:

e Prepare the surface by cleaning it and allowing it to dry
completely if you have applied a liquid solution. The pad
is adhesive on both sides, and has protective layers on
both ends.

e Remove one layer and apply it to the back of the wall
mount. Remove the other layer and press firmly onto the
surface where the holster will be located.

For an alternate option, perform the following steps:
e Position the mount on a smooth, stable, vertical surface.
e Using the back of the wall mount as a guide, drill two
holes the same size as the anchors supplied; then, push

the anchors completely into the drilled opening.

e Insert the screws through the holder and fasten it securely
to the anchors and the wall.
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2.8.3. Schick WiFi Interface Mount Installation

Delivery system mounts (Part number B2400260)
for the Schick Wil Interface offer quick access and
temporary placement while working chair-side.

To install the mount, perform the following steps.

e Insert the Schick WiFi Interface mounting holder into an

empty slot in the chair’s instrument panel. The mount will
fit most panels and should feel secure when placed inside
the slot.

With the Sensor cable end of the Schick WiFi Interface
facing you, and the Schick logo easily readable, slide the
Schick WiFi1 Interface into the mount, allowing the side
rails on the Schick WiFi Interface to guide it along the
gripping arms of the mount. Small stops at the end of the
Schick WiFi1 Interface will prevent it from dropping.

The Schick WiFi Interface can be left in this mount when
using your Schick WiFi system. When your Schick WiFi
Interface is not in use, please remove it from the mount
and place it into the Docking Station so that it can remain
charged and ready for the next exam.

Schick WiFi User Guide
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2.8.4. Schick WiFi Interface Radiation Shield Clip

Designed for the lead aprons used during X-ray
exams, radiation shield clips (Part number
B2400250) for the Schick WiFi Interface also offer
quick access and temporary placement while
working chair-side.

To attach the clip, perform the following step.

e With the Sensor cable end of the Schick WiFi Interface
facing you, and the Schick logo easily readable, slide the
Schick WiFi Interface into the clip, allowing the side rails
on the Schick WiFi Interface to guide it along the
gripping arms of the mount. Small stops at the end of the
Schick WiFi1 Interface will prevent it from dropping.
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3.Controls and LED Indicators

3.1. Schick WiFi Docking Station

USB LED

Schick WiFi Interface

There is a single connector for the Schick Wili Interface to connect
to the Docking Station. Located near the connector is a green
indicator that illuminates and remains on when a Schick Wiki

Interface is connected. When the Schick WiFi Interface is removed,
this LED is off.

The Power LED illuminates when external power is available to the
Docking Station. External power is supplied by a wall outlet and
charges the Schick WiFi Interface when connected to the Docking
Station.

PLEASE NOTE: Use only the power adapter (Schick P/N
A3303200) supplied with the Schick WiFi Docking Station and be
sure to verify that its plug contacts are compatible for use in your
country and region.

The USB LED illuminates when the USB cable is connected during
initial configuration. Except for this purpose, the USB cable may be
disconnected. The following illustration (Figure 8) identifies the
controls and indicators on the Docking Station.

USB Connector

j (initial programming)

Power Connector

LED

e
- L/ /’ (external power)

ﬁ Power LED

Docking Connector |

Figure 8. Schick Wili Docking Station Connections and LEDs
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3.2. Schick WiFi Interface

PLEASE NOTE: To retain pairing with a specific workstation and to charge the battery,
we recommend storing the Schick WiFi Interface in the Docking Station when not in use.

A multi-purpose pushbutton (Figure 9) on the Schick WiFi Interface
controls power to the device and turns it on or off. When the Schick
WiFi Interface is on, pressing and holding the pushbutton for 6
seconds turns it off. If the Schick WiFi Interface is off, pressing the
pushbutton turns the device on.

The LED located on the Schick WiFi Interface displays a range of
colors (Figure 10, Figure 11, and Figure 12 on page 43) to provide
visual feedback regarding the battery charge and during boot-up and
firmware upgrade operations. During regular use, the LED reflects
the status of battery power from fully charged (green) to a level
requiring recharge (red).

We strongly recommend recharging the battery before it displays
red, for the following reasons: (a) When the LED displays red, there
may be insufficient battery charge to complete image acquisition and
display, thus exposing the patient to unnecessary radiation. (b) A
battery whose charge is completely consumed will require a longer
period to recharge.

Recharging the battery will take approximately one hour or longer, if
the battery charge is significantly low or depleted. (To recharge fully from
a depleted state may be as long as three hours.) Table 4 on page 44 provides
additional information about the Schick WiFi Interface LED and
describes the various patterns associated with its operation.

| ON/OFF Pushbutton |
/;:":\
i _—
I e \\( | Dockina Connector |
I | LED |

WiFi ironal |

Figure 9. Schick Wili Interface Pushbutton Switch and LED Indicator
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Figure 10. Schick Wili Interface LED Color Range during Operation

(Full Battery Charge in Green to No Battery Chatge in Red)

This color is displayed during Schick WiFi
Interface boot-up

/_A_\

Figure 11. Schick WiFi Interface LED Color Range during Boot-up

This color is displayed during Schick WiFi
Interface firmware upgrade

/_A_\

Figure 12. Schick WiFi Interface LED Color Range during Firmware Upgrade
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Table 4. Schick Wik'i Interface LED Indications (Status)

PATTERN

ACTION

LED INDICATION

No Sensor Connected Sensor Connected

Preparing device for use

(power on and boot-up) Purple (solid) (same)
Searchlr}g for Wik Short flash every %2 second (same)
connection

. . . Long flash followed by two
Unpaired, waiting to pair short flashes (same)
Pairing Solid color (no flashing) (same)

Paired (indication differs

Ready for image acquisition

whether Sensor is connected | Short flash every 1 second (glows from dim to bright,
or disconnected) “breathing”)
Transferring image data Flashing rapidly (same)

PLEASE NOTE: LED colors that range from green to yellow to orange indicate the battery charge of the Schick WiFi
Interface (from full to medium to low). Refer to Table 5 for additional information.

Table 5. Schick WiFi Interface LED Indications (Battery Power)

LED INDICATION

BATTERY POWER LEVEL

Normal Operation

Green 100-70%
Yellow 69-40%
Orange 39-0%
Red Empty
Firmware Upgrade
Blue 100-70%
Yellow 69-40%
Orange 39-0%
Red Empty
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4.Operation

4.1. Configuring the Schick WiFi Interface

Configuring the Schick WiFi Interface with the WiFi Configuration
Utility is necessary before using it with imaging applications. (This
procedure is described in Section 2.4 on page 25.)

The utility is needed just once when connecting the Schick Wili
Interface to the wireless network in the office, or if there changes in
the wireless network itself. The Schick WiFi Interface must be in the
Docking Station, and the USB cable from the Docking Station must
be connected to the PC. After a successful configuration, the USB
cable can be removed from the Docking Station.

The Wili Configuration Utility detects wireless networks in the area
and reports whether they are open or secure, their signal strength,
and the channel they use.

PLEASE NOTE: Hidden networks may not be detected by the Configuration
Utdlity. In this case, you will need to click File > Create a new network and add the
network name, password, and security for the hidden network. When you
connect successfully, the network will appear in the list of available networks.

Pressing the Connect button initiates the setup for the Schick Wili
Interface to communicate with the wireless network. If the network
is secure, you will be required to enter the password for it.

PLEASE NOTE: Pressing the Refresh button will help verify the status of
networks and devices reported by the Wik Configuration Utlity.

4.1.1. Configuration Utility Description

Information about the Configuration Utility can be found in Table 6
on page 46 and in Figure 13 on page 47.
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Table 6. Configuration Utility Desctiption

ITEM

SECTION

DESCRIPTION

File Menu

Refreshes the list of available networks; opens the “Connect to
new network” window to enable the Schick WiFi Interface to
connect to a different wireless network than the one selected
currently; enables the Schick Wik Interface to forget a wireless
network it was previously configured for;? creates a new network
that the Schick WiFi Interface can connect to; resets the Schick
WiFi Interface to its factory settings and disconnects from its
current network; and closes the utility.

Tools Menu

Starts diagnostic tests, which are automated tests of the Schick
WiFi system; enables the selection of a different port in the
event of a conflict with another USB device; provides an
alternate method for upgrading Flash firmware if the
recommended procedure (via Web Server and Upgrade Utility) has
failed or if the Schick WiFi Interface is not booting up propetly.

Help Menu

Accesses help topics for the Configuration Utility and finds the
software version of the Configuration Ultility.

Serial Number and
Friendly Name

Serial Numbers uniquely identify the Schick WiFi Interface.
Friendly Names are user-assigned and can be set in the Web
Server and Upgrade Ultility under the Settings tab.

Region Setting*

United States
Canada
Europe
Spain

France

Japan

Channels 1 through 11
Channels 1 through 11
Channels 1 through 13
Channels 10 and 11
Channels 10 through 13
Channels 1 through 14

Available Networks

Lists available wireless networks and information about them

Refresh

Verifies the status of networks and devices

Selected Network

The specific wireless network to which the Schick Wik interface
is currently connected (shown in bold). Previously configured
network connections will also appear in bold letters.

Connect

Establishes a connection to an available wireless network

Status

Connection and IP address status

Configured Network

Information about the wireless network connection between the
Schick WiFi Interface and the PC workstation

Discovery Method*

SSDP for security routers; otherwise, UDP

Status Bar

Displays messages or other Schick Wil system information

3 The network that will be “forgotten” is the one currently selected under Available Networks. If multiple networks were
configured, the Schick WiFi Interface will “forget” the selected one and will attempt to connect to one of the others.

4 Available in Schick WiFi software version 2.1 and higher.
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L L

Available Networks ® @

-
,-:y)(ﬁFl Con guratl Utility - =N

File Tecls Help

Wifi Interface Serial Number: @ P234567
Wifi Interface Friendly Name: LisasOp
WiFi Interface Region 5etting: ® | United States v‘

Mame Security Signal Channel “
‘I’ TestRack (H) WPAMWPA & 1
T Zoom WERA/WPRAZ = 10
1" NETGEAR:PAT_TEST WPASWPAZ = 11
1" development WEASNPAZ = 1
1 corpZtest WPA Enterprise = B
T visitor WPA/WPAZ = 6 T
Currently Configured Network @

MName: TestRack Connection status -4(

IP Address: 172.16.1.102 ® @ IP Address status '(
® Discovery Method: [S5DP =

IP Assignment:  Dynamic (DHCP)
MAC Address:  00:0B:6C:B4:2D:5E

™)

E Status: Ready

Figure 13. Wiki Configuration Utility
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4.1.2. New Network Connections (Open, WEP,

WPA/MWPA2)

Information about creating a new wireless network connection using
WPA/WPAZ2 security can be found in Table 7 and in Figure 14 on
page 48.

Table 7. New Network Connection (WPA/WPA2 Security)

ITEM SECTION DESCRIPTION
A Name Text box for the name of the new wireless network
B Mode Access Point or Ad-Hoc
C Security Open, WEP, WPA/WPA2
D | Password Password for secured ne@orks (the password assigned to the
office router or access point)
E Method Dynamic, Static, Ad-Hoc
F Connect Establishes a connection to this wireless network
- -
-+ Connect Network @M
Connect to new network
@ Marme: lestRack
Made: 1’ Access Point
@ || Securty: WPA/WPA2
@ | Passward: sesssssns
IP Address Configuration
® Method: Dynamic (DHCP) =
]
| |
| |
® I Connect | [ Cancel ]
Figure 14. Connect to New Network (Open, WEP, WPA/WPA2)
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4.1.3. New Network Connections (WPA
Enterprise)

Information about creating a new wireless network connection using
WPA/WPA2 security can be found in Table 7 and in Figure 14 on
page 48.

Networks that require a greater degree of security than WPA/WPA2
can specify WPA Enterprises. These networks may employ security
certificates to verify each wireless device and user on the network.
The certificates themselves are created by the local IT technician or
manager, who also sets the specific requirements and the
authentication options for implementation.

The Schick WiFi Configuration Utility provides support for
Enterprise security and can import security certificates, if they are
needed. Several options for authentication may be available on the
server: some of these, such as Smart Card, require certificates; others,
such as Protected EAP (PEAP), and Secured Password (EAP-
MSCHAP v2), do not.

If you are following the authentication for “Smart Card or other
certificate”, please perform the following steps:

¢ In the Schick WiFi Configuration Ultility, double-click on
the name of the network with WPA Enterprise security.

e The Connect Network page opens.

e Username can be blank in instances when this
information is contained within the certificate

e Password can be blank in instances when this information
is contained within the certificate

e Import and then select the certificate file (for example,.
cert.pfx)

e Private Key required

e Private Key Secret required

5 Available in Schick WiFi software version 2.1 and higher.
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If you are following the authentication for “Protected EAP (PEAP)
or “Secured Password (EAP-MSCHAP v2), please perform the
following steps:

e In the Schick WiFi Configuration Ultility, double-click on
the name of the network with WPA Enterprise security.

e The Connect Network page opens.

e Username required and may be a user name or domain
name such as User or User@softwaretest.local (where
softwaretest is the name of the domain).

e Password required

e No certificate should be selected

Table 8. New Network Connection (WPA Enterprise Security)

ITEM SECTION DESCRIPTION
A | Name Text box for the name of the new wireless network
B Mode Access Point
C Security WPA Enterprise
Although they are shown here, user name and password may be
D | User Authentication contained within the security certificate and so may be blank in
this case
E Certificates Private key and private key secret are required.
F | Manage Certificates Imports security certificate
IP Address .
G . Dynamic (DHCP)
Configuration
H | Connect Establishes a connection to this wireless network
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.~ Connect Netwo e =

Connect to new network

@ Marne: EAP
Maode: 1" Access Point
@ Security: WRPA Enterprise
@ User Authentication
Username: Tester@softwaretest.local
Password: stssanans
]
® Certificates
Private Key: [ vl H

Private Key Secret:

CA certificate: [ vl %

Client certificate: [ vl %

® [ Manage Certificates ]

@ IP Address Configuration

Method: ‘ Dynamic (DHCPF) "

@l Connect | [ Cancel l

Figure 15. Connect to New Network (WPA Enterprise)
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4.1.4. Diagnostic Tests

Diagnostic tests are available under the Tools menu in the event
communication issues occur. Prior to starting these tests, please place
the Schick Wili Interface into the Docking Station.

e Wili Charger Connection — Checks the USB connection to
the Docking Station.

e WiFi Interface Serial Number — Reads the Schick WiFi
Interface serial number.

e WiFi Network Connection — Checks whether a connection
to a wireless network can be established.

e Validate IP Address — Checks for an IP address from a
wireless network.

e Wili Interface Network Ping — Checks whether the
workstation and the Schick WiFi interface are on the same
network

e WilFi Monitor Network Discovery — Checks whether you
can see the Schick WiFi interface in the Interface
Management window.

e Wil Interface Pairing — Checks whether the workstation
can connect to the Schick WiFi interface over a wireless
network.
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Table 9. Configuration Utility Diagnostic Tests

DIaGNostic ERROR MESSAGE USER ACTION
TEST
WiFi Charger Unable to communicate with Confirm that Schick WiFi Interface is in
Connection charger Docking Station and run test again
WiFi Interface (No message) Confirm that Schick WiFi Interface is in
Serial Number © a8 Docking Station and run test again
WiFi Network Wi Interface is not currently | Make sure that your wireless network is listed as
Connection connected to a Wiki network available on the Configuration Utility
Wik'i Inferface da”. e Make sure that you have the correct IP
currently have a valid IP i
assignment for the currently configured network
address g Y gu
Validate IP . " :
Address Turn off the Schick WiFi Interface, then turn it
Wil'i interface is susceptible to | back on to restore normal operation. If the
dropped broadcast packets problem occurs repeatedly, it may be related to
the access point
Wil Interface Unable to ping remote Wiki Make sure that Schick Wili Interface and
Network Ping Interface computer workstation are on the same network
- . Make sure that either UPnP ports (UDP 1900
Wi Monitor Unable to discover Wiki and 7900) are not blocked OR that UDP port
Network )
. Interface messages 55005 is not blocked by firewalls or routers on
Discovery
your network
WiFi Interface Unable 1o connect 1o WiFi Make sure that TCP ports 55000 and 55001 are
. not blocked by firewalls or routers on your
Pairing Interface

network

"+ WiFi Configuration Test
e —

Click Start to run several diagnostic tests on the WiFi Interface

Description
WiFi Charger connection
WiFi Interface Serial Number
WiFi Metwork Connection
Validate IP address
WiFi Interface network ping
WiFi Monitor network discovery

WiFi Interface Pairing

Status Results

Success

Success

Success

Success

Success

Success

AN NN T N N

Success

Close

Figure 16. Diagnostic Tests
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4.2. Pairing

PLEASE NOTE: To retain pairing with a specific workstation and to charge the battery,
we recommend storing the Schick WiFi Interface in the Docking Station when not in use.

To acquire an image on any PC workstation, a specific Schick Wil
Interface must be “paired” with that workstation. A workstation will
only receive images from its paired Schick Wil Interface, and the
Schick WiFi Interface will only transmit to the computer to which it
is paired. Only one Schick WiFi Interface may be paired with a
workstation at a time. If there is no paired Schick WiFi Interface
when the imaging application starts, you will be prompted to select a
Schick WiFi Interface for pairing.

Once a Schick WiFi Interface is paired with a workstation, it will
remain paired unless: (a) the Interface is powered down by user
interaction or by reaching the time out value indicated on the Settings
tab of the Web Server and Upgrade Utility, (b) the workstation shuts
down, or (c) the Interface is paired with another workstation via an
RFID reader.

(Pairing is described in Section 2.5 on page 30.)

4.3. Pairing Recovery and Auto Pairing

PLEASE NOTE: To retain pairing with a specific workstation and to charge the battery,
we recommend storing the Schick WiFi Interface in the Docking Station when not in use.

If pairing is lost during a network error, system error, or computer
reboot, Schick WiFi software will automatically re-pair the Schick
WiFi interface and workstation. This feature is called “Pairing
Recovery”.

A specific Schick WiFi Interface can pair exclusively with a specific
workstation by enabling the “Auto Pairing” setting. In offices where
a Schick WiFi Interface is used always with the same workstation,
Auto Pairing eliminates having to choose this pairing manually.

While primarily a benefit for smaller offices, enabling the Auto Pair
setting is not appropriate in dental practices that routinely pair Schick
WiFi Interfaces to different workstations.

(Auto Pairing is described in Section 5.4.5 on page 108).
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4.4. Pairing (RFID Option)

With RFID pairing (also called RFID “tagging”), simply touch the
Schick WiFi Interface to the RFID reader and the computer
workstation automatically detects the Schick WiFi Interface and pairs
to it. If the workstation is paired to a different Schick WiFi Interface,
it unpairs automatically from that one and pairs to the new one.
RFID tagging is described in Section 2.6 on page 33.

There is one exception, however.

If you have decided to pair a particular Schick WiFi Interface with a
particular workstation exclusively (“Auto Pairing”), RFID tagging will
not override this choice.

The RFID reader can be connected to any USB port on the
computer workstation, including those on monitor displays,
keyboards, and external hubs. When connecting the RFID reader to a
USB port, choose a location easily accessible to you. Also consider
that a brief message will appear on the computer display to confirm
pairing, so you will want to be able to view the screen when using
RFID pairing.

RFID readers for the Schick WiFi system are available from Sirona
Dental.
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4.5. Unpaliring

Unpairing a Schick WiFi Interface can be done only from the Wiki
Interface Management window on the workstation where it is
currently paired, or by using the RFID reader to “tag” a new PC
workstation for pairing, which automatically unpairs the Schick Wili
Interface from the workstation it was previously paired to.

If a Schick Wili Interface is turned off, it will become unpaired
automatically. (Schick WiFi Interfaces turn off automatically after 15
minutes, but this duration can be changed by the Power Timeout
setting in the Web Server and Upgrade Utility). We recommend
keeping the Schick WiFi Interface in the Docking Station when not
in use, which retains pairing and charges the Schick WiFi Interface
battery.

When a Schick WiFi Interface is unpaired, it will be available for
pairing with any workstation, if it is still detected by the wireless
network.

PLEASE NOTE: If the imaging application is closed, the Schick WiFi
Interface will not unpair automatically.
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Table 10. Schick WiFi Interface Status Showing Paired / Unpaitred Conditions

SCHICK WIFI INTERFACE

SENSOR

EXAMPLE

Paired

Not in Docking Station

Connected

WiFi Interface Sta‘hl =

File Options

Paired Interface: Battery Level:
[ows
Sensor sn: Signal Strength:
EEal B

Not in Docking Station

Not Connected

Paired In Docking Station Not Connected
| WiFi Interface Stalul - ==
|| File Options
|| Paired Interface: Battery Level:
ol |
Sensor sfn: Signal Strength:
Paired Not in Docking Station | Not Connected
WiFi Interface Stalul - =
|| File Opticns
|| Paired Interface: Battery Level:
[sopaTs ]
Sensor s/n: Signal Strength:
Unpaired In Docking Station or Connected or

WiFi Interface StalusA u

File Options

Paired Interface: Battery Level:
I Not Paired |

Sensor sfn: Signal Strength:
I Not Connected |

Schick WiFi User Guide

B1051080 Rev. 4

57




4.6. Auto Resend

On rare occasions, an X-ray image may fail to transfer propetly to
your imaging software. In this situation, you may have seen a white
image, instead of one with diagnostic detail, in the exam viewbox.

There may be several reasons why this might happen, including
wireless interference or other external factors. Auto Resend, which is
new to Schick WilFi software, will try to recover the image
automatically, even if the normal transfer of the image was
interrupted.

Auto Resend is always enabled, so there is nothing you need to do to
have this feature available as you are taking X-ray images.

If an image fails to transfer properly, you will be notified that the
software has detected this problem and is trying to recover the image
from the Schick WiFi device itself. An example of the message is
shown below.

98% Complete

- —

Image transfer was interrupted. Please wait as the system
recovers the image automatically.

Cancel

Recovering the image and displaying it in your software should take a
relatively short amount of time, depending on your wireless network.
We suggest that you allow enough time for image recovery, which
could take up to a minute. A much longer period may indicate that
the image could not be recovered automatically. In this case, click on
the Cancel button in the message dialog and try to resend the image
manually, as described on the next page.
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4.7. Resend Last Image Manually

The Resend option is appropriate when a corrupted image, caused by
improper data transfer, is displayed on a system that otherwise
appears to be operating normally. In this instance, it may be possible
to retrieve an uncorrupted version of the image directly from the
Sensor without having to expose the patient to additional X-rays.

Image Resend has been improved to be more robust as well. Even if
you disconnect or change Sensors, an image that failed to transfer
properly may be recovered using this feature.

NOTE: In a previous software release, Image Resend was located in the Wiki
Interface Management and Status windows under the Options menn. This has
changed, and Image Resend is located in the Xray/Image menu of CDR
DICOM. (Image Resend is available in CDR DICOM version 5.4 and higher,
but it is not available at the time of this document’s release in EagleSoft or
Patterson Imaging.)

In the patient exam, select on an empty viewbox and choose “Resend
Image” from CDR DICOM’s Xray/Image menu or from the context
menu by clicking the right mouse button. The resent image will
display in the viewbox.

Image resend is supported in AutoTake and non-AutoTake (manual)
modes. Only the last acquired image can be retransmitted, although it
can be retransmitted multiple times, if necessary.

If a Schick Wiki Interface is turned off (manually or automatically),
the last acquired image can no longer be retransmitted.
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4.8. Image Enhancement (Schick Elite)

Options are available to enhance the appearance of X-ray images
before they are displayed on your screen or monitor. There are four
options — Edge Pro, Edge High, Edge Low, and Smooth — and the
names themselves generally describe the enhancements they perform.
Edge Pro, a recent addition, displays a smoother image with lower
contrast and brightness for customers who prefer their images
displayed with these characteristics. ¢

For sample X-rays that illustrate the effects of these enhancements,
please refer to Figure 17, Figure 18, and Figure 19. Using these
options is discretionary, so you can try each of them and select the
one that works best for you. Alternatively, you can choose to turn off
these enhancements, if you prefer.

Please note that the image enhancements, when applied, cannot be
undone or changed, nor will they affect images you have acquired
already.

¢ NOTE: The Edge Pro filter is more sensitive to severe underexposure than other Schick Elite enhancements. Very light
images are an indication that the dose is insufficient for the anatomy being imaged and a slight increase in exposure time is

indicated.
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4.8.1. Enabling Image Enhancement

On new installations, Image Enhancement is enabled by default with
the Edge Pro option selected. If the option was disabled however, it
can be re-enabled at the X-ray control properties options page (in
CDR DICOM, browse to the System menu, select X-ray Settings,
click on the Image tab, and mark the Apply Image Enhancement
checkbox).

Bl
Xray Acquisition Control Properties M

[ %ay | Calboration | Sensor | Imags |

Schick Elite Schick 33
Apply Image Enhancement Resolution: High A
Levell  |Edge pro - [] Apply Fixed Enhancement

Smooth
Edge Low
Edge HiEh

o) (Comen [ ] [ ]

All enhancements are available from the drop-down menu. After
selecting one of the enhancements, click Apply, and click OK to
close the X-ray acquisition options page.
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4.8.2. Disabling Image Enhancement

Image Enhancement can be disabled at any time by clicking the
“Apply Image Enhancement” checkbox again, which removes the

checkmark.

When the checkbox is cleared, all of the enhancements for Schick
Elite sensors are unavailable.

-

Xray Acquisition Control Properties

[ %=y [ Calibration | Sensor | Image |

Schick Elite

I || Apply Image Enhancement

Level: |Edgepro

Schick 33
Resolution: High

[ Apply Fixed Enhancement

0K

J U Concdl | [ pemv ]|

Help
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Figure 17. Enhancements: Edge Pro (top) and Smooth (bottom)
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Figure 18. Enhancements: Edge High (top) and Edge Low (bottom)
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Figure 19. Enhancements: None Applied
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4.9. High Resolution Image Acquisition (Schick 33)

Schick 33 Sensors have a theoretical resolution (Nyguist Limiting
Frequency) of 33.3 1p/mm (33.3 line pairs per millimeter). The Sensor is
capable of acquiring images in either high resolution mode or normal
mode. High-resolution mode, which is unique to Schick 33 Sensors,
captures a level of detail measured at 28 Ip/mm.

'The above image shows a line pair measurement phantom captured with a size 2
Schick 33 Sensot. The phantom measutes up to 28 Ip/mm, which the Schick
Sensor is able to demonstrate in the enlarged section highlighted in red.

The increase in image information in high-resolution mode means
also that the transfer from acquisition-to-display time may be higher.
On newer PCs with multiple processors this difference is negligible.
High-resolution images are also physically larger in terms of their file
sizes: approximately 8 MB / image with a size 2 Sensor.
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4.9.1. Selecting High Resolution Acquisition

Taking high-resolution images with Schick 33 Sensors is enabled by
default (High Resolution Acquisition option selected). If this option
has been turned off and you wish to re-enable it, open the X-ray
acquisition options page and click on the High Resolution
Acquisition checkbox. (In CDR DICOM, browse to the System menn,
select X-ray Settings, click on the Sensor tab, and select High from the Resolution
drop-down menu item. Click Apply, and click OK to close the X-ray acquisition

options page.)

Xray Acquisition Contrel Properties Tt S

[ Xy | Calibration | Sensor | mage |

Schick Elite Schick 33

Apply Image Enhancement Resolutiof:

Level: Edae Pro - || Apply Fixed Enhancement

ok || Cancel |[ ey ][ Hebp
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4.9.2. Selecting Standard Resolution Acquisition

Images can be acquired in Standard resolution using the same Schick
33 drop-down menu under X-ray acquisition options. Physically
smaller (in terms of file size) when compared with high-resolution
images, standard-resolution images are approximately 2 MB per
image with a Size 2 Sensor. High-resolution images are approximately
8 MB per image with the same size Sensor.

Xray Acquisition Control Properties lé]

| Hray | Calibration | Sensor| Image: |

Schick Elite Schick 33

Apply Image Enhancement ResolutioQ: Standard -

Level:  [Edge Pro - [~ Apply Fixed Enhancement

ok | [ Cancel Apply Help
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4.10. Sharpen and High-Resolution Images

Sharpen is a tool for image enhancement developed specifically for
Schick 33 images. Sharpen uses a combination of different functions
to optimize images for detail and contrast. It is applied automatically
to every image taken with Schick 33 Sensors.

To adjust image sharpness dynamically, a Sharpen slider and a
Sharpen cursor are available. The slider can be shown or hidden. It
can also be positioned at the Top or Bottom areas outside the image,
or as an Overlay on the image.

Show shder

Enhancement
Select User
Select Task
Edit Users

Figure 20. Sharpen Slider Menu Selections

4.10.1. Showing the Sharpen Slider

To show the Sharpen slider (if currently hidden), perform the
following steps:

1. Move your cursor over a high-resolution image (taken with a
Schick 33 Sensor).

2. Press the right-mouse button to open a short menu.
3. Select Sharpen Slider.

4. Click on Show Slider (this will gpp/y the check mark and
display the slider).
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4.10.2. Hiding the Sharpen Slider

Although the Sharpen slider is shown by default when high-
resolution images are displayed, it can also be hidden to maximize the
image area inside the Zoom window. Please note that even with the
slider hidden, image sharpness can be adjusted dynamically using the
Sharpen cursor, by following the steps in the next paragraph.

1.

Move your cursor over a high-resolution image (taken with a
Schick 33 Sensor.

Press the right-mouse button to open a short menu.
Select Sharpen Slider.

Click on Show Slider (this will remove the check mark and hide
the slider).

4.10.3. Positioning the Sharpen Slider

To position the Sharpen slider, perform the following steps:

1.

Move your cursor over a high-resolution image (taken with a
Schick 33 Sensor.

Press the right-mouse button to open a short menu.
Select Sharpen Slider.

Verify that the Show Slider item is checked. If checked,
continue with the next step. If unchecked, click on this item
and repeat steps 1 through 3.

Click on the position in the Zoom Window where the slider
will be shown (Top, Bottom, or Overlay). For examples, see the
following figures.
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Figure 23. Sharpen Slider (Overlay Position)
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4.10.4. Using the Sharpen Slider

The Sharpen slider is used to adjust image sharpness dynamically, as
additional enhancement to the automatic sharpening that occurs
when high-resolution images are displayed. A Sharpen percentage is
shown on the slider and serves as an easy way to remember the
specific Sharpen settings that are most useful to you.

User profiles, described in detail in Section 4.11 on page 74 can save
Sharpness settings for various commonly-performed clinical tasks
such as Endodontic, Periodontic, General Dentistry, Restorative, and
Hygiene. For example, once you have set a Sharpness setting for a
particular clinical task, the slider will move automatically to that
position.

Please note that manual adjustments of image sharpness by using the

Sharpen slider or the Sharpen cursor are not saved with the image.

4.10.5. Using the Sharpen Cursor

Adjusting the slider dynamically is one way of varying the effects of
the Sharpen tool. It is also possible to use the Sharpen cursor to
change the amount of sharpening. To adjust image sharpness
dynamically by using the cursor, perform the following steps:

1. Move your cursor over a high-resolution image (taken with a
Schick 33 Sensor.

2. Press the right-mouse button to open a short menu.
3. Select Sharpen.

4. Press the left-mouse button, which changes the Sharpen
graphic to a two-arrow cursor.

5. Keeping the mouse button depressed, move the cursor up to
increase sharpness.

6.  Keeping the mouse button depressed, move the cursor down
to decrease sharpness

7. Sharpen remains active until another tool (like Zoom, Pan, or
Brightness / Contrast) is selected.
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4.10.6. Using Sharpen with Other Image
Enhancements

Since Sharpen is applied automatically each time a Schick 33 image is
displayed, the Sharpen enhancement cannot be saved with the image
in the way that other image tools in the Zoom Window are (/ike
Colorize, Equalize, ete.). For the same reason, Sharpen does not appear
on the Change List (Edit > List All Changes in the CDR Zoom Window),
nor are user adjustments in Sharpen retained when the Zoom
Window is closed.

Please note that the image enhancements introduced with the Schick Elite

product — Edge Pro, Edge High, Edge I.ow, and Smooth — have no effect on
images acquired with Schick 33 Sensors and their effects are effectively ignored.

(1hey are still cavailable, when enabled, for innages taken with Schick Elite Sensors,)
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4.11. Diagnostic Tasks and User Profiles

Schick 33 sensors and supporting software enable the clinician to
optimize image presentation to a level appropriate for the diagnostic
task being performed. These settings are applied at display time and
do not affect the original image data. Diagnostic Task selections can
be changed for any image, from one task to another, and back at will.

The different task selections optimize the contrast and brightness of
the displayed image to improve visibility of the anatomical structures
important for that diagnostic task. Refer to the table below.

In addition to contrast optimization, the visibility of some anatomical
structures benefit from additional image sharpening. Selecting any
diagnostic task applies an initial level of sharpening to the image. A
slider control is available to dynamically change the level of image
sharpness in real time. Users also use the slider with the “Save As
Default” button to change the default sharpen level to their personal
viewing preferences for each clinical task described here.

The table below shows the diagnostic task to select to improve
visibility of relevant dental anatomy. Figure 25 and Figure 26 on pages
77 and 78, repectively, provide several sample images.

Table 11. Diagnostic Task Descriptions and Default Values

DIAGNOSTIC OPTIMIZED SHARPEN DEFAULT
TASK ANATOMY (USER CHANGEABLE)

Balanced for general

1 0
General Dentistry tooth and bone display 7%
Root apices, pulp
Endodontic chamber, lamina dura, 70%

periodontal ligament,
cementum

Periodontic Alveolar and crestal 50%
bone, calculus

Enamel, Dentin, DEJ,

1 0
Restorative CEJ 85%
Balanced for general
Hygiene tooth and bone display 55%

but with a lighter tone
to the image

To create your own user profile, or to perform other profile actions,
complete the steps in the following paragraphs.
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4.11.1. How to Add a User Name

1.

In the Zoom Window, right-click on an image acquired with
a Schick 33 Sensor.

Click on the Edit Usets menu item.
Click on the Add User button.

Click inside the New User name text box and type in a user
name.

Click Close.

To verify, right-click on the image again and click on Select
User. The new user name will appear in the menu.

4.11.2. How to Edit a User Name

1.

In the Zoom window, right-click on an image acquired with a
Schick 33 Sensor.

Click on the Edit Users menu item.
Locate the user name you wish to edit.

Double-click on the user name, which becomes an editable
text box.

Type in a new name for this user.
Click Close.

To verify, right-click on the image again and click on Select
User. The edited name will appear in the menu.

4.11.3. How to Delete a User Name

1.

S

In the Zoom window, right-click on an image acquired with a
Schick 33 Sensor.

Click on the Edit Users menu item.

Select the user name you wish to delete from the list.
Click on the Delete user button.

Click Close.

To verity, right-click on the image again and click on Select
User. The edited name will appear in the menu.
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4.11.4. How to Edit a Task

1. In the Zoom window, right-click on an image acquired with a
Schick 33 Sensor.

2. Click on the Select User menu item.

3. Select a user name from the list.

Note: The [default] name is not editable. To create your own custom profile, add
auser name and then perform the following steps.

4. Right-click on the image again and click on the Select Task.
5. Choose one of the task categories from the list.

6.  Adjust the slider to a level of Sharpening that you feel is
appropriate.

7. Click on the Save as default button.

8. When prompted, click Yes to save the new the Sharpen value
as the default setting for this task category and this user.

9.  To check or compare the Sharpen settings with other user
profiles or default values, click on Edit User, which opens the
user profile dialog.

: F .\ Zoom
-i- Pan

Brightness/Contrast

< sh
&= Sharpen

Sharpen Slider

Select User v [default]
Select Task New User

Edit Users

2
& Sharpen

Sharpen Slider

Enhancement

Select User
Endodontic
Periodontic
General Dentistry
Restorative

Figure 24. User Profile Menu Selections Hygiene

(Shown expanded at right)
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—
Save as default

Figure 25. Diagnostic Tasks: General Dentistry (top) and Endodontic (bottom)
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Sharpen: 50% ave as !gn

Sharpen: 85% G Ve as gg!

Figure 26. Diagnostic Tasks: Periodontic (top) and Restorative (bottom)
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Figure 27. Diagnostic Task: Hygiene
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4.12. Enhancement Modes

Dynamic image enhancement with Schick 33 Sensors represents a
departure from the traditional method of image processing that is
performed at the time of acquisition. Schick 33 Sensors perform only
basic processing at acquisition and instead process the image at
display time, providing customers with the flexibility to adjust various
enhancements and mapping choices after the image is acquired.

This flexibility, which is always available to Schick 33 customers with
CDR DICOM, EagleSoft, and Sidexis imaging software, include the
ability to adjust the amount of sharpness in an image after it is
acquired and to choose and customize brightness and contrast
settings in diagnostic tasks. Additional enhancement is also possible.

Two modes are available as described in the following table.

MODE DESCRIPTION

A Displays image features in vivid detail and supports a
wide sharpening range.

B Provides a softer enhancement, especially around object
edges, and supports a tighter sharpening range.

Mode A is the enhancement initally provided for Schick 33 Sensors.
Mode B offers a slightly different appearance, but may be attractive
to customers who prefer a generally softer enhancement in their
images.

Select User
Select Task
Edit Users

Figure 28. Enhancement Mode Selections
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4.13. Schick 33 Image Enhancement

An alternate option in the way Schick 33 images are presented for
display is available. This alternative, known as fixed enhancement, is
intended primarily for third-party imaging customers that do not
have access to the dynamic processing in CDR Dicom, EagleSoft and
Sidexis and would not otherwise benefit from the enhancements
available for Schick 33 high-resolution images.

Fixed enhancement is also an option to CDR Dicom, Eaglesoft, and
Sidexis customers, although this choice will disable the benefits
associated with dynamic processing, such as the availability of the
Sharpen slider, Diagnostic tasks, and Enhancement modes after the
image is presented for display.

In CDR Dicom, image enhancement choices are selected in the
Image tab of the Xray Acquisition Control Properties page.

i —— b
Xray Acquisition Control Properties &8 - - ﬁ

| ¥ray | Calibration | Sensor | Image |

Schick Elite Schick 33

Apply Image Enhancement Resolution: Standard -
Level: [¥]iapply Fixed Enhancement:

Enabling this feature disables the dynamic processing available
in software programs like COR Dicom, Eaglesoft, and Sidexis.
Click on the Help button below for more information.

Mode: (@ Enhancement A

(7 Enhancement B

Task: General Dentistry =

I

Sharpen: 50%

| oKk || cancel || oy || Hep

Figure 29. Selecting Fixed Enhancement in CDR Dicom
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Referring to the previous image, additional information about the
differences between fixed and dynamic enhancement may be found
in the following table.

Table 12. Selecting Fixed or Dynamic Enhancement

(See Figure 29 for reference)

APPLY FIXED ENHANCEMENT RESULTS

Applies dynamic processing in CDR Dicom, EagleSoft,
and Sidexis software.

Enables users to adjust the sharpness slider, to choose
any diagnostic task, and to select a different
enhancement mode AFTER the image is displayed.

] Not Selected

This box is unchecked by default.

Applies fixed processing in any imaging software
compatible with Schick 33 sensors.

Enables users to select a specific degree of sharpness, a
M Selected* particular diagnostic task, and either enhancement mode
BEFORE the image is acquired.

The effects of fixed processing cannot be changed after
image display.

* Selecting this option by CDR DICOM, EagleSoft, and Sidexis customers will disable dynamic processing
and the availability of the Sharpen slider, Diagnostic tasks, and Enhancement Modes after the image is
presented for display.
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4.13.1. Dynamic Enhancement

A description of dynamic enhancement may be found in Section 4.13
on page 81..

4.13.2. Fixed Enhancement

A description of the options available with fixed enhancement is
described in the following table.

Table 13. Fixed Enhancement in CDR Dicom

(See Figure 29 for reference)

FIXED ENHANCEMENT RESULTS

Enables users to select a specific degree of sharpness,
along a scale from 0 to 100%, BEFORE the image is
acquired.

Sharpen Slider
The selected sharpness is applied in addition to the other
choices made for fixed enhancement, such as Mode and

Task

Provides a preview of how an image might be affected
Sample Image Preview by user-selected fixed enhancement choices (Mode,
Task, and Sharpen).

Provides the original image enhancement processing for
Mode A Schick 33 sensors. It displays image features in vivid
detail and supports a wide sharpening range.

Provides a softer enhancement, especially around object

Mode B edges, and supports a tighter sharpening range.
Provides the same diagnostic tasks optimized for
Task brightness and contrast described previously in this

document.

NOTE: The subtle difference between Mode A and B may be difficult to see in the sample image preview.
1t may be helpful to move the slider to 100% to note the differences more easily.
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4.14. CDR AutoDetect

The CDR AutoDetect feature instantly recognizes when Schick
intraoral devices are connected. Like CDR USB high-speed (HS)
remotes and Schick Elite USB remotes, paired Schick Wiki
Interfaces in the Schick WiFi system are supported by this feature,
skipping the additional step of manually selecting a different Schick
device before using it.

CDR AutoDetect is enabled by default. If, however, it was disabled
and you wish to re-enable it, open the X-ray acquisition options page
(in CDR DICOM, browse to the System menn and select X-ray Settings). 1f
the CDR AutoDetect box is not checked, mark the checkbox (Figure
30) to enable this option. You might also notice that the Hardware
Type drop-down box becomes unavailable, as detection of Schick
USB devices and Sensors will now be performed automatically

It is also possible to interact with the CDR AutoDetect feature. You
can do this by clicking on the notification window when it appears,
ot by double-clicking on the CDR AutoDetect icon that is present in
the Windows system tray when CDR AutoDetect is enabled.
Performing this action will display a window (Figure 31) that lists all
the “known” Schick USB devices currently connected to the system.

When the imaging software is loaded initially, or when CDR
AutoDetect is initially turned on, the system will populate the
monitor with all known currently connected devices. If several are
listed, the one that is highlighted signifies the currently active device.
To use a different device, select it, and then click the Select Device
button.

PLEASE NOTE: Schick WiFi Interfaces must be paired to the
workstation to be listed by the CDR AutoDetect Monitor.
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Hray |Calibmtion | Sensor | Image |

Expozure Timeout [g]:

Integrate Phoenix [sec/10):

7
7

Integrate Time [sec/10);
Feset Duration [uSec):
Trigger Threzh:

Trigger Count:

1/0 Part:

Initial B ampup [Sec):

Second Rampup [Sec):

Hardware Type: Use CDR Autodetect
CDR Elite USE Remaote

Calibrate Image
[ Auta Azcept Image
Equalize Image
Apply Spot R emowver
Subtract dark image
Acquire 12 bit image
Automatic Exposure Control
M apping:

Monlinear [Traditional]

Figure 30. X-ray Properties Page with CDR Autodetect Option Selected

" CDR Autodetect Monito [

| Device Mame

CDR Elte

Select Device | Hide Monitor I

Figure 31. CDR Autodetect Monitor
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5.Web Server and Upgrade Utility

The Schick WiFi Web Server and Upgrade Utility can be used to
accomplish the following:

e Display Schick WiFi Interface status
e Perform firmware upgrades
e Perform diagnostic tests

e Display user-configurable settings.

Although we recommend that the Schick Wiki Interface be placed in
the Docking Station for Flash and FPGA upgrades, these upgrades
can be performed with the device outside the Docking Station.

In this case, the battery charge must be 50% or higher to ensure there
is no interruption to power during the upgrade process. A loss of
power, which could occur if battery power fell to empty during the
upgrade process, would result in an incomplete upgrade and could
prevent the device from operating.
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5.1. Status Tab

The Status tab (shown below) includes software version and date
information, the Schick WiFi Interface serial number, and Sensor
information (if the Sensor is connected to the Schick WiFi Interface).

Web Server and Upgrade Utility English _*

Ermars Upgrade Dagrestic Sertings

Status
T window cisplays slatus and device snformation,

r=Schick WiFi Interface Versi
00.00.192

[~ Schick WiFi Interface Serial Number
2001059

[ Sentar Verslon (firmware / hardwara)
2.6 ¢ 2.0

[~ Sensor Serial Number
12015592

Copyright (c) Sirona Dental, Inc.

The Status tab includes the following information:

e Schick WiFi Interface Version — This is the current

version of Flash firmware programmed into the Schick
WiFi Interface.

e Schick WiFi Interface Serial Number — This is the
product serial number located on the bottom outer
surface of the Schick WiFi Interface

e Sensor Version (firmware / hardware) — This is the
current version of the firmware and hardware
programmed into the Sensor

e Sensor Serial Number — This is the product serial number
located on the back outer surface of the Sensor
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5.2. Firmware Upgrade Tab

The Firmware Upgrade tab (shown below) includes features to install
the latest firmware improvements to your product and we strongly
recommend that you install them when directed. These upgrades are
simple to perform so you can update the product yourself by
following a few simple steps.

Web Server and Upgrade Utility Engish

St Cragreitc etirg

Firmware Upgrades

Clore: your g proginm sed makes sure ol hardwine 3 coreeited.

S / A

Current version: Current version (firmware / hardware): Current version:
03.80.182

Cl'pm_n'"l | Wofile chosen | Eheose File | No file chosen | Choose File | No file chosen

[ St [ St | [ Sabent

To upgrade, browse the flle and click the Submit button.

Progress: %a

The Firmware Upgrade tab includes the following information:

e Schick WiFi Interface Flash upgrades (on page 87)
e Schick WiFi Interface FPGA upgrades (on page 93)

e Sensor firmware upgrades (on page 98).
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5.2.1. Flash Upgrade

the Docking Station

PLEASE NOTE: For this procedure, we recommend that the Schick WiFi Interface be in

SteP 1

Open the Wireless Monitor on a PC

WiFi Interface Status

wotkstation. To do this, click on the Wireless

Monitor icon located in the System Tray and
select Schick Wili Interface Management.

STEP 2

A. Check the list of Schick WiFi Interfaces
and identify the one you wish to upgrade.

B. Make sure that it is unpaired.

File Options

Workstation name: w7
Currently Paired WiFi Interface: No Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name I Signal Battery | Sensor I Status I Paired PC I
PO00217 Excellent 100 In Charger Available

STEP 3

Right-click on the device to be upgraded and
select “Open Device Web Interface.” The Web
Server and Upgrade Utility page is displayed.

File Options

Workstation name: w7
Currently Paired WiFi Interface: Mo Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name | Signial | Battery | Sensor | Status | Paired PC |
POO2677 Excellent 100 In Charger Paired englabw?
000BSCCCFBCC Excellent 101 Available
P121212 Excellent 101 Available
P0O00217 Excellent 100 In Charger Available
Pair
Open Device Web Interface
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STEP 4

Click on the Firmware Upgrade tab.

Web Server and Upgrade Utility (English [7]
Firmware Upgrades
Close your imaging program and make sure all hardware is connected.
Flash FPGA Sensor
Current version: Current version (firmware / hardware): Current version (firmware / hardware):
02.02.343 8 /14
Browse. . Browse... Browse. .
Progress: 0%
To upgrade, browse the file and click the Submit button.

STEP 5

A. Under the “Flash” group, click the
Browse button.

B. Browse for the “ulmage” file (may be
available on disk or by web download)
and click Open.

C. Click the Submit button (only once).

Flash
Current version:
02.02.343

C\Upgrade from File_Marcor |_Browse...
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STEP 6

Notice the status bar at the bottom of the
Web Server and Upgrade Ultility page. As the
new firmware is installed, its status is
indicated by the progress bar.

Web Server and Upgrade Utility

(English [~]

Diagnostic Settings

Firmware Upgrades

Close your imaging program and make sure all hardware is connected.

&

Current version:
02.02.343

Flash FPGA

&

Current version (firmware / hardware):

Sensor

o
o

Current version (firmware / hardware):
8 /14

Browse...
Submit

Progress: 34%
Upgrading. ..
NENNNENNNNENNNENNNENNNNNNNERRNEERE

Submit

Browse...
Submit

Browse...

STEP 7
A. When the firmware upgrade is complete, Flash

the Schick WiFi Interface will reboot

automatically.

Current version:

B. After the Schick WiFi Interface reboots, 0=2005T32

wait approximately for 10 seconds for

the LED to start flashing.
C. In the web browser, press the F5 key to Browse...

refresh the window. S
D. Verity the updated version of the

firmware, which is 03.00.192 in this
example.

(verify new firmware version)
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STEP 7 (CONTINUED)

E. Return to the WiFi Interface Management
window and confirm that the upgraded
Schick WiFi Interface continues to appear
in the list of detected devices.

F. Pair the upgraded Schick WiFi Interface
with a PC workstation to verify this
function.

G. Take several sample exposures to verify
image quality.

File Options

Workstation name: w7

Currently Paired WiFi Interface: FOODZ217

Detected WiFi Interfaces:

Interface Name Signal Batter: Sensor Status Paired PC
PODD217 Excellent 100 In Charger Paired w7
PO00230 Fair 100 In Charger Available

(check Schick WiFi Interface Management)
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5.2.2. Flash Upgrade (Alternate)

PLEASE NOTE: This is an alternate method for upgrading Flash firmware in the Schick
WiFi Interface if the recommended procedure has failed or if the Schick WiFi Interface is
not booting up properly.

For an alternate method to upgrade Flash firmware, perform the following steps:

1.

Make sure that the Schick Wiki Interface to be upgraded is placed in the Docking
Station (if it is not there already). Also make sure that the USB cable is connected
from the PC to the Docking Station.

Open the Wili Configuration Utility on a PC workstation. To do this, click Start >
Sirona Dental > Schick Wiki > WiFi Configuration Utlity.

At the Wili Configuration Utility, click Tools > Upgrade from File.

At the Schick WiFi Upgrade or Recovery window, browse for the “ulmage” file
(may be available on disk or by web download) and click Open.

Click Install. The Flash upgrade occurs in two parts: the first part displays the
message, "Loading file . . . " and the second patt is "Installing firmware ... "

IMPORTANT: Do not remove the Schick WiFi Interface from the Docking Station during a
firmware upgrade. When the message, "Schick WiFi upgrade or recovery was
successful" is displayed, the Schick WiFi Interface may be removed and is ready for
normal use.

9.

When the firmware upgrade is complete, the Schick Wili Interface will reboot
automatically. After the Schick Wiki Interface reboots, wait approximately for 10
seconds for the LED to start flashing.

Return to the Wik Interface Management window and confirm that the upgraded
Schick WiFi1 Interface continues to appear in the list of detected devices. Select the
upgraded device and click File > Open Selected Device Web Interface.

When the Web Server and Upgrade Utility window is displayed, select the Firmware
Upgrade tab. Check the Flash group and verify the updated version of the firmware,
which is 02.02.343 at the time of this document's release.

Pair the upgraded Schick WiFi Interface with a PC workstation to verify this function.

10. Take several sample exposures to verify image quality.
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5.2.3. FPGA Upgrade

PLEASE NOTE: For this procedure, we recommend that the Schick WiFi Interface be in
the Docking Station.

SteP 1

Open the Wili Interface Management window _

. ) . WiFi Interface Status
(if not open already). To do this, click on the
Wireless Monitor icon located in the System :

Tray and select Schick Wili Interface
Management.

STEP 2

A. Check the list of Schick WiFi Interfaces
and identify the one you wish to upgrade.

B. Make sure that it is unpaired.

File Options

‘Workstation name: w7
Currently Paired WiFi Interface: Mo Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name | Signal Battery | Sensor | Status | Paired PC |
PODO217 Excellent 100 In Charger Available

STEP 3

Right-click on the device to be upgraded and
select “Open Device Web Interface.” The Web
Server and Upgrade Utility page is displayed.

File Options

Workstation name: w7
Currently Paired WiFi Interface: Mo Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name | Signial | Battery | Sensor | Status | Paired PC |
PO02677 Excellent 100 In Charger Paired englabw?
000BSCCCFBCC Excellent 101 Available
P121212 Excellent 101 Available
P0O00217 Excellent 100 In Charger Available
Pair
Open Device Web Interface
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STEP 4

Click on the Firmware Upgrade tab.

Web Server and Upgrade Utility English
Firmware Upgrades
Close your imaging program and make sure all hardware is connected.
Flash FPGA Sensor
Current version: Current version (firmware / hardware): Current version :
03.00.182 8 /14
Browse. .. Browse. .. Browse. .
Progress: 0%
To upgrade, browse the file and click the Submit button.

STEP 5

A. Under the “FPGA” group, click the
Browse button.

B. Browse for the “.dat” file (may be

available on disk or by web download)
and click Open.

C. Click the Submit button (only once).

FPGA

Ve

Current version (firmware / hardware):
8 /14

C\Upgrade from File_Marcor | Browse.
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STEP 6

Notice the status bar at the bottom of the
Web Server and Upgrade Ultility page. As the
new firmware is installed, its status is
indicated by the progress bar.

Web Server and Upgrade Utility
 sttus |

Diagnostic Settings

Firmware Upgrades

Close your imaging program and make sure all hardware is connected.

Ve

Current version:

Flash FPGA

e

03.00.192

Current version (firmware / hardware):
4

Browse. .

Submit Submit

Progress: 34%
Upgrading...
NENNNNNNNNENNNNNNNENNNNNNNERNNEERD

Sensor
Current version :
Browse. . Browse. .
Submit

STEP 7

A. After the Schick WiFi Interface reboots,
wait approximately for 10 seconds for the

LED to start flashing.

B. In the web browser where the successful
upgrade message is displayed, click the
Back button.

Press the F5 key to refresh the window.

D. Verify the updated version of the

firmware, which is 2.0/1.4 in this
example.

NOTE: Your particular Sensor may present a
different hardware version than the one shown (“14”).

FPGA

e

Current version (firmware / hardware):
Z.0 /14

Browse...
Submit

(verify new firmware version)
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STEP 7 (CONTINUED)

E. Return to the WiFi Interface Management
window and confirm that the upgraded
Schick WiFi Interface continues to appear
in the list of detected devices.

F. Pair the upgraded Schick WilFi Interface
with a PC workstation to verify this
function.

G. Take several sample exposures to verify
image quality.

File Options

Waorkstation name: w7

Currently Paired WiFi Interface: FPODD217

Detected WiFi Interfaces:

Interface Name Signal Batter Sensor Status Paired PC
POOD217 Excellent 100 In Charger Paired w7
PO00230 Fair 100 In Charger Available

(check Schick WiFi Interface Management)
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5.2.4. Sensor Upgrade

PLEASE NOTE: For this procedure, make sure that the Schick WiFi Interface is not in the
Docking Station. Also, be sure that the Sensor to be upgraded is connected to the Schick
WiFi Interface. Tum on the Schick WiFi Interface, if it is not on already, and wait about 10
seconds for the LED to start flashing.

SteP 1

Open the Wili Interface Management window _

. g . WiFi Interface Status
(if not open already). To do this, click on the
Wireless Monitor icon located in the System :

Tray and select Schick Wili Interface
Management.

(o0} G |-

STEP 2

A. Check the list of Schick WiFi Interfaces
and identify the one you wish to upgrade.

B. Make sure that it is unpaired.

File Options

Workstation name: w7
Currently Paired WiFi Interface: No Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name I Signal Battery | Sensor I Status I Paired PC I
PO00217 Excellent 100 In Charger Available

STEP 3

Right-click on the device to be upgraded and
select “Open Device Web Interface.” The Web
Server and Upgrade Utility page is displayed.

File Options

Workstation name: w7
Currently Paired WiFi Interface: Mo Paired WiFi Interface Pair

Detected WiFi Interfaces:

Interface Name | Signial | Battery | sensor | status | Paired PC |
PO02677 Excellent 100 In Charger Paired englabw?
000BSCCCFECT Excellent 101 Available
P121212 Excellent 101 Available
P0O00217 Excellent 100 In Charger Available
Pair
Open Device Web Interface
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STEP 4

Click on the Firmware Upgrade tab.

Web Server and Upgrade Utility English
Firmware Upgrades
Close your imaging program and make sure all hardware is connected.
Flash FPGA Sensor
Current version: Current version (firmware / hardware): Current version :
03.00.182 2.0 /14 2.4
Browse. .. Browse. .. Browse. .
Progress: 0%
To upgrade, browse the file and click the Submit button.

STEP 5

A.

Under the “Sensor” group, click the
Browse button.

Browse for the “.hex” file (may be
available on disk or by web download)
and click Open.

Click the Submit button (only once).

Sensor

e

Current version :
2.4

C\Upgrade from File_Marcor | Browse..
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STEP 6

Notice the status bar at the bottom of the
Web Server and Upgrade Ultility page. As the
new firmware is installed, its status is
indicated by the progress bar.

Web Server and Upgrade Utility
e |

Diagnostic Settings

Firmware Upgrades

Close your imaging program and make sure all hardware is connected.

Ve

Current version:

Flash FPGA

Ve

03.00.192 2.0 /14

Current version (firmware / hardware):

Browse...

Submit Submit

Progress: 34%
Upgrading, ..
NEENNENNNNENNNNNNNENNENNNNERNNEERD

(English [~]
Sensor
Current version :
2.4
Browse... Browse...
Submit

STEP 7

After the Schick WiFi Interface reboots,
wait approximately 10 seconds for the
LED to start flashing.

In the web browser where the successful
upgrade message is displayed, click the
Back button.

Press the F5 key to refresh the window.

Verify the updated version of the
firmware, which is 2.6 in this example.

Sensor

e

Current version:’
2.6

Browse...
Submit

(verify new firmware version)
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STEP 7 (CONTINUED)

E. Return to the WiFi Interface
Management window and confirm that
the upgraded Schick WiFi Interface
continues to appear in the list of detected
devices.

F. Pair the upgraded Schick WiFi Interface
with a PC workstation to verify this
function.

G. Take several sample exposures to verify
image quality.

File Options

Workstation name: w7
Currently Paired WiFi Interface: FPODD217 Unpair

Detected WiFi Interfaces:

Interface Name Signal Batter; Sensor Status Paired PC
PODD217 Excellent 100 In Charger Paired w7
PO00230 Fair 100 In Charger Available

(check Schick WiFi Interface Management)
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5.3. Diagnostic Tab

The Diagnostic tab (shown below) includes a bandwidth test, which
measures how fast an image can be transferred wirelessly from the
Schick WiFi Interface to the PC workstation for display; a set of
hardware tests that evaluate the wireless and functional connections
of the Schick WiFi system, and voltage and firmware tests of the
Sensor.

1
Web Server and Upgrade Utility Crguh =
St Firrvsare upgrades Dagroate ] Settrgt
Diagnostic
poed Test= = Hardware Test—
This is a bandwidth test to measure how fast
an Image can be transferred.
Start Test
Click on the button to start speed test,
Start Test
Se J
Senser Test Senser Voltage Is Nerma J P ' 4
Sensor Firmware is Verified ‘,
-l

5.3.1. Speed Test

The Speed test determines how quickly a binned image (a Schick
Elite or Standard Resolution image) or unbinned image (a Schick 33
or High Resolution image) can be transferred wirelessly to the host
computer for display. The test is available by clicking the Start Test
button in the Speed Test section.

To produce the speed results, the test uses the current Wiki
connection to transfer data that corresponds to a typical binned and
unbinned image. Image data from an actual patient exposure is not
used in this test.

Binned images may take approximately up to 6 seconds to transfer
and display, and unbinned images up to 10 seconds. If the results
exceed these general averages, some optimization of the WiFi
environment may be indicated. In this case, installing an access point
dedicated to transferring Schick WiFi images, rather than sharing the
bandwidth with other resources such as Internet usage, may improve
image transfer times.
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5.3.2. Hardware Tests

The following Hardware tests, which provide a quick summary of the
overall wireless and hardware status of the Schick Wili system, are
available by clicking the Start Test button in the Hardware Test
section:

e Wil Interface Connection - Test passes when pattern data sent
from the Schick WiFi Interface to the host computer is verified
successfully

e Wil Interface to Sensor Connection - Test passes when data
sent from the Sensor to the Schick WiFi Interface, and from the
Schick WiF1 Interface to the host computer, is verified
successfully

e Sensor Connection - Test passes when pixel data, without an X-
ray exposure, is read successfully by the Sensor, sent to the
Schick WiFi Interface, and from the Schick WiFi Interface to the
host computer, and is verified successfully

Table 14 on page 104 describes the possible outcomes of the tests
and the corrective actions associated with them.

5.3.3. Sensor Tests

The Sensor Test consists of two parts, Sensor voltage and Sensor
firmware verification, as described below.

e Sensor Voltage - Test determines if a low voltage condition
exists in the Sensor, which may prevent the system from
operating normally. In the event you receive an indication of low
voltage after running the test, you will be prompted with a
message suggesting several possible actions to resolve the issue.

e Sensor Firmware - Test determines if the Sensor firmware is
valid, meaning that it can be used by the Sensor and is not
corrupted. The test cannot determine, however, if the correct
firmware “version” has been installed for your Sensor. If you
have a question about the firmware used in the Schick WiFi
system, please contact Product Support for more information.
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5.3.4. Additional Troubleshooting

If an error condition occurs in the Schick WiFi system, several
actions can be taken immediately that may help identify the issue and

possibly resolve it.

e Turn off the Schick WiFi Interface and turn it back on again.
Repeat the Hardware Tests.

e Upgrade the Flash firmware. This is particularly important if you
have recently updated the Schick Wik system with new software

and drivers. Repeat the Hardware Tests.

e Try using a different Sensor, if one is available, and repeat the

Hardware Tests.

e Verify that the router or access point is operating propetly.

If none of these steps prove effective, refer to the following table,
and Product Support, as needed, for additional information.

Table 14. Web Server Diagnostic Tests

WIFI INTERFACE
CONNECTION

WIFI INTERFACE TO
SENSOR CONNECTION

SENSOR
CONNECTION

CORRECTIVE
ACTION

Pass

Fail

Fail

Replace Sensor cable.
Replace Sensor if
problem persists.

Pass

Pass

Fail

Connect alternate
Sensor if available.
Replace Sensor if
problem persists.

Fail

Fail

Fail

Perform Flash upgrade
(under Firmware
Upgrade tab). Contact
Product Support if
problem persists.

Pass

Pass

Pass

None
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5.4. Settings Tab

PLEASE NOTE: When customizing settings, make sure that the particular Schick WiFi
Interface whose settings you wish to change is listed as “Available” in the WiFi Interface
Management window.

The Settings tab (shown below) includes custom options that are
user-configurable.

Web Server and Upgrade Utility Eaghat:_%

Status Firmware Ungrade Duagraste ! Setiogt

Settings

Restare factory defaults Restoe

Although changing these settings is optional, they are included here
to enhance your use of the Schick WiFi system. While other
enhancements may be implemented in future software versions, the
following items are currently available.

e Use “friendly names” to identify Schick WiFi1 Interfaces.

e Select the appropriate battery (based on the battery label) when
performing Schick WiFi Interface battery replacement. 7

e Change the time before the start of the “power timeout.”

e Enable “Sleep Timeout” to extend the battery life of the Schick
Wil Interface.

e FEnable “Auto Pairing” to pair a particular Schick WiFi Interface
with a particular workstation, exclusively.

7 Available in Schick WiFi software version 2.1 and higher.
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5.4.1. Friendly Names

The use of friendly names to identify the Schick Wili Interfaces in
your office helps personalize these devices. Once they are given
friendly names, Schick Willi Interfaces display this information in
WiFi Interface Management so you know instantly which ones are
“paired” or “available” or “charging.” Friendly names can be any
combination of letters and numbers, but not symbols or spaces,
which are currently unsupported. Click Save to retain the changes.

5.4.2. WiFi Interface Battery

This setting® is used after replacing the original “Schick” battery in
the Schick WiFi Interface with the more recent “Sirona” battery
(batteries can be distinguished by the logos on their respective labels).
Choosing the correct setting helps to ensure that the battery level of
your new Sirona battery is reported accurately by the Wireless
Monitor and in the Wili Interface Management screen. Click Save to
retain the changes.

2 LITHIUM POLYNER
P ic RECHWRGEARLE BUTTERY
Cll k & "

2 EEENEN Conpany -
PLEASE RECYCLE CR
P/N: B2410240 SIN: PAT XXXX-X DISPOSE OF PROPERLY
PAT LI-POLYMER BATTERY PACK il T—
37V 250mAh 0.925WH  MM/YY T

Figure 32. Schick Battery

2 X CE

WiFi Interface Battery Pack ;&:ER’?} POLgh;:rRrERV
3.7V 400mAh 1.48WH PLEASE FOLLOW LOCAL REG-
P/N: B2410220 REF 6404375 e e oarenics
SIN: XXXXXXXX MMAYYYY A S

- Do not shori-circuit battery

NI OO D e
- Use specified charger only

Figure 33. Sirona Battery

5.4.3. Power Timeout

Managing power for the Schick Wili Interface is important to ensure
the device is ready for imaging when you need it. The default setting
for power timeout is 15 minutes, meaning that after 15 minutes in an
idle state, when the device is not in use and is not being charged in
the Docking Station, the Schick Wili Interface will power down
automatically. This setting is customizable.

To change the “friendly name” and / or “power timeout,” double-
click inside the text box to highlight the current value, and then type
in the new value. Be sure to click Save to retain the changes.

8 Available in Schick WiFi software version 2.1 and higher.
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5.4.4. Sleep Timeout

The primary reason for implementing this new feature is to extend
the battery life of your Schick WiFi Interface. Sleep Mode does this
by introducing a power-savings option when the Schick Wili
Interface is not charging in the Docking Station.

If you already follow our guidelines by charging the Schick Wili
Interface in the Docking Station when not in use, you should
continue to follow that practice. Sleep Mode has more to do with the
Schick Wili Interface when it is outside the Docking Station and not
in use.

When the Schick WiFi Interface enters Sleep mode, the power
supplied by the battery is reduced and the intensity of the LED is
likewise diminished.

To "wake up" the Schick WiFi Interface in preparation for use, press
the Power button once. Other user actions such as connecting or
disconnecting the Sensor will also cancel Sleep Mode and prepare the
Schick WiFi Interface and the Sensor for imaging. You will not need
to re-pair the Schick Wiki Interface.

Sleep Mode is a customizable option that can be enabled or disabled
in the Settings tab of the Web Server and Upgrade Utility. By default,
this setting is enabled with a 5-minute timeout, meaning that after
being idle for an interval of 5 minutes, outside the Docking Station,
the Schick WiFi Interface will enter Sleep Mode to preserve battery
power. During Sleep Mode, the Schick WiFi Interface remains paired,
but AutoTake will flash red.

Click Save to retain the changes.
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5.4.5. Auto Pairing

It is possible to exclusively "Auto Pair" a Schick WiFi Interface and
PC workstation. You may wish to do this if you always use one
specific Schick WiFi Interface with one particular workstation. If this
setting is enabled, it will eliminate having to choose the pairing
manually.

PLEASE NOTE: While primarily a benefit for smaller offices, enabling the Auto
Pairing setting in the Web Server and Upgrade Ultlity is not appropriate in dental
practices that routinely pair Schick Wik Interfaces to different workstations

If you have decided to pair a particular Schick WiFi Interface
exclusively with a particular workstation, RFID Tagging will not
override this choice if Auto Pairing has been enabled.

To enable Auto Pairing between one specific Schick WiFi Interface
and one specific workstation, perform the following steps:

1. Open the Wiki Interface Management window (right- click
on the Wireless Monitor icon in the System Tray and select
it.)

2. At the upper left side of the window is the "Workstation
name" and the computer name following it. You will need
this name in Step 6 (if this is the workstation being auto-
paired), so please make a note of it.

3. Select the Schick WiF1 Interface you wish to pair, then right-
click and select "Open Device Web Interface.”

4. Select the Web Server Settings tab and locate the "Enable
Auto Pairing" checkbox and the text box.

5. Click on the checkbox to mark it.

6. Inside the “Automatically pair with workstation” text box,
type in the computer name you noted in Step 2.

7. Click Save.
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Schick WiFi Interfaces that are set with Auto Pairing enabled can be
identified on the Interface Management window in the following
way. Under the "Paired PC" column, the description "-Only" will be
added after the workstation name.

A Schick WiFi Interface that is auto-paired cannot be paired to any
other workstation, either at the Interface Management window or by
RFID reader, until the "Enable Auto Pairing" checkbox is cleared.

5.4.6. Restore Factory Defaults

This option resets all the customized settings on the Settings tab to
their original (factory) values.

The reset is restricted to the settings on this tab and in this way
differs from the “Reset to factory defaults” option in the Wiki
Configuration Ultility, which resets the Schick WilFi Interface to its
factory defaults.
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6.2. Sensor Cleaning and Disinfecting

In a clinical use environment, the health care provider should wear
protective disposable gloves and cover the Sensor with a hygienic
barrier. Before using the Sensor the first time, and before every new
patient, the following protocol is recommended:

1.

10.

11.

12.

13.

Remove and discatd all protective hygienic barriers and /
or sheaths from the Sensor prior to removing disposable
gloves.

Place the Sensor on a tray covered by a disposable liner,
or in a receptacle that can be thoroughly disinfected.

Remove and discard gloves.
Wash hands and put on a new pair of disposable gloves.
Disconnect the Sensor from the Schick WiFi Interface.

If the Sensor or cable are visibly soiled (e.g., with blood
or saliva), each should be cleaned with a soapy cloth or
paper towel, and then dried with a clean lint-free cloth or
paper towel.

Thoroughly wipe the Sensor and cable with the
disinfecting product recommended in Section 6.5 on page
112. Do not expose the Sensor cable connectors to any
amount of liquid.

Repeat step 7. When the Sensor has been sprayed or
wiped two times, continue with the following steps.

Remove potential chemical build-up from the Sensor by
wiping it with a sterile lap sponge saturated with de-
ionized watet.

Use a sterile dry lap sponge to dry the Sensor or cable, as
needed.

Place the Sensor in a clean environment, ready for use.
Reconnect the Sensor.

Remove and discard gloves.
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6.7. Protective Holsters, Mounts, and Clips

Sensor holsters are available as a convenient way to
keep your Sensors easily accessible and safe from
accidental damage and misuse. They can be installed on
most surfaces, using the materials supplied with the
holster.

Installation steps can be found in Section 2.8.1 on page 37.

=
Y |

\ 4

Wall mounts for the Docking Station also provide
accessibility and protection, and, like the Sensor
holsters, they can be applied to most surfaces. The wall
mount itself is molded to the Docking Station,
supplying a stable and secure fit for the device.

Installation steps can be found in Section 2.8.2 on page 38.

Delivery system mounts for the Schick WiFi Interface
offer quick access and temporary placement while
working chair-side. Designed to fit most instrument
panels, the mount is used to store the Schick Wiki
Interface temporarily during patient exams.

When not in use, we recommend placing the Schick WiFi Interface in
the Docking Station so it can be charged and ready for the next

€xam.

Installation steps can be found in Section 2.8.3 on page 39.

Designed for the lead aprons used during X-ray exams,
the radiation shield clips for the Schick WiFi Interface
also offer quick access and temporary placement while
working chair-side.

Installation steps can be found in Section 2.8.4 on page 40.
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7. Maintenance

There are no user-serviceable parts in the Schick WilFi Docking
Station. Service of the Schick WiFi Interface is limited to battery
replacement and service of Schick sensors is limited to cable
replacement. However, before operating the system, customers shall
check the Schick WiFi system for any signs of physical damage or
defect. If detected, other system units can be substituted if they are
available. Contact your local distributor of Sirona Dental products for
further instructions.

7.1. Damaged Sensor

In the event of physical damage to the Sensor, customers shall
discontinue use of that Sensor, substitute another Sensor (if
available), and contact their local Schick distributor for further
instructions.

7.2 Part Numbers

The following table provides customer-orderable part number
information for Schick WiFi Sensors, kits, and related hardware.

Table 15. Schick WikFi Replacement Kit Part Numbers

ITEM PART NUMBER
Schick WiFi Interface Kit B2410050
Replacement Schick WiFi PAT Battery Kit B2410140
Schick WiFi Docking Station Kit B2420050

Table 16. Schick WiFi Room and Upgrade Kit Part Numbers

ITEM PART NUMBER
Schick WiFi Room Kit B2400010
Schick WiFi Room Kit (without Sensor cables) B2400001
Schick WiFi Room Kit (International) B2400014
Schick WiFi Upgrade System Shipping Kit B2400000
Schick WiFi Upgrade System Shipping Kit (International) B2400004
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Table 17. Schick WiFi Accessories

ITEM PART NUMBER
Schick WiFi RFID Reader B2440100
Schick WiFi RFID Reader Extension Cable W1125400
Schick WiFi Docking Station Wall Mount B2420135
Schick WiFi Interface Radiation Shield Clip B2400250
Schick WiFi Interface Delivery Unit Mount B2400260
Schick WiFi Spare Interface Battery B2410140
Schick WiFi Docking Station USB Cable - 2m B2250151

Table 18. Schick WiFi with Schick Elite Sensor Orderable Item Part Numbets

SENSOR CABLE . PART
ITEM DESCRIPTION
LENGTH NUMBER

Size 0 Sensor Kit 6 ft (1.8 m) Schick WiFi SO Sensor Ship Kit 6 ft B2403101
Size 0 Sensor Kit 9ft (2.7 m) Schick WiFi SO Sensor Ship Kit 9 ft B2403102
Size 0 Sensor Kit 3£t (0.9 m) Schick WiFi SO Sensor Ship Kit 3 ft B2403103
Size 0 Sensor Kit 18 in (0.5 m) Schick WiFi SO Sensor Ship Kit 18 in B2403100
Size 0 Sensor System Ship Kit . Schick WiFi SO Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2403000
Size 0 Se.nsor System Ship Kit 18 in (0.5 m) Schmk WiFi SQ Sensor System Ship Kit B2403004
(International) 18 in (International Power Supply)
Size 1 Sensor Kit 6 ft (1.8 m) Schick WiFi S1 Sensor Ship Kit 6 ft B2401101
Size 1 Sensor Kit 9 ft (2.7 m) Schick WiFi S1 Sensor Ship Kit 9 ft B2401102
Size 1 Sensor Kit 3 ft (0.9 m) Schick WiFi S1 Sensor Ship Kit 3 ft B2401103
Size 1 Sensor Kit 18 in (0.5 m) Schick WiFi S1 Sensor Ship Kit 18 in B2401100
Size 1 Sensor System Ship Kit . Schick WiFi S1Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2401000
Size 1 Se.nsor System Ship Kit 18in (0.5 m) Schmk WiFi 51 Sensor System Ship Kit B2401004
(International) 18 in (International Power Supply)
Size 2 Sensor Kit 6 ft (1.8 m) Schick WiFi S2 Sensor Ship Kit 6 ft B2402101
Size 2 Sensor Kit 9 ft (2.7 m) Schick WiFi S2 Sensor Ship Kit 9 ft B2402102
Size 2 Sensor Kit 3ft (1.8 m) Schick WiFi S2 Sensor Ship Kit 3 ft B2402103
Size 2 Sensor Kit 18 in (0.5 m) Schick WiFi S2 Sensor Ship Kit 18 in B2402100
Size 2 Sensor System Ship Kit . Schick WiFi S2 Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2402000
Size 2 Se.nsor System Ship Kit 18 in (0.5 m) Schmk WiFi Sg Sensor System Ship Kit B2402004
(International) 18 in (International Power Supply)
Schick WiFi USB Interface o Schick WiFi USB Interface B2410100
Assembly Assembly
Schick WiFi Docking Station o Schick WiFi Docking Station B2420100
Assembly Assembly
Schick WiFi Docking Station Schick WiFi Docking Station
Power Supply Kit — Power Supply Kit B2420110
(Us) (Us)
Schick WiFi Docking Station Schick WiFi Docking Station
Power Supply Kit — Power Supply Kit B2420111
(International) (International)
Schick WiFi Universal Sensor 6 fit (1.8 m) Schick WiFi Universal Sensor Cables B2400168
Cables 6 ft
Schick WiFi User Guide B1051080 Rev. 4 115




SENSOR CABLE . PART
ITEM DESCRIPTION
LENGTH NUMBER
Schick WiFi Universal Sensor 9 ft (2.7 m) Schick WiFi Universal Sensor Cables B2400166
Cables Oft
Schick WiFi Universal Sensor 3 e (1.8 m) Schick WiFi Universal Sensor Cables B2400167
Cables 3 ft
Schick WiFi Universal Sensor 18in (0.5 m) Schmk WiFi Universal Sensor Cables B2400165
Cables 18 in
Schick WiFi Cable Kit 6 ft (1.8 m) Schick WiFi Cable Kit 6 ft B2400121
Schick WiFi Cable Kit 9 ft (2.7 m) Schick WiFi Cable Kit 9 ft B2400122
Schick WiFi Cable Kit 3 ft (0.9 m) Schick WiFi Cable Kit 3 ft B2400123
Schick WiFi Cable Kit 18 in (0.5 m) Schick WiFi Cable Kit 18 in B2400120
USB Cable Kit 16.5 ft (5 m) USB A/B 5M Cable with Ferrite B2250150
USB Cable Kit 6.5 ft (2 m) USB A/B 2M Cable with Ferrite B2250151
USB Cable Kit 1.6 ft (0.5 m) USB A/B 0.5M Cable with Ferrite B2250152
Table 19. Schick WiFi with Schick 33 Sensor Orderable Item Part Numbers
SENSOR CABLE PART
ITEM ) DESCRIPTION
LENGTH NUMBER

Size 0 Sensor Kit 6 ft (1.8 m) Schick WiFi SO Sensor Ship Kit 6 ft B2433101
Size 0 Sensor Kit 9 ft (2.7 m) Schick WiFi SO Sensor Ship Kit 9 ft B2433102
Size 0 Sensor Kit 3 ft (0.9 m) Schick WiFi SO Sensor Ship Kit 3 ft B2433103
Size 0 Sensor Kit 18 in (0.5 m) Schick WiFi SO Sensor Ship Kit 18 in B2433100
Size 0 Sensor System Ship Kit . Schick WiFi SO Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2433000
Size 0 Se.nsor System Ship Kit 18in (0.5 m) Schmk WiFi SQ Sensor System Ship Kit B2433004
(International) 18 in (International Power Supply)
Size 1 Sensor Kit 6 ft (1.8 m) Schick WiFi S1 Sensor Ship Kit 6 ft B2431101
Size 1 Sensor Kit 9 ft (2.7 m) Schick WiFi S1 Sensor Ship Kit 9 ft B2431102
Size 1 Sensor Kit 3 ft (0.9 m) Schick WiFi S1 Sensor Ship Kit 3 ft B2431103
Size 1 Sensor Kit 18 in (0.5 m) Schick WiFi S1 Sensor Ship Kit 18 in B2431100
Size 1 Sensor System Ship Kit . Schick WiFi S1Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2431000
Size 1 Se.nsor System Ship Kit 18 in (0.5 m) Schmk WiFi Sl‘ Sensor System Ship Kit B2431004
(International) 18 in (International Power Supply)
Size 2 Sensor Kit 6 ft (1.8 m) Schick WiFi S2 Sensor Ship Kit 6 ft B2432101
Size 2 Sensor Kit 9 ft (2.7 m) Schick WiFi S2 Sensor Ship Kit 9 ft B2432102
Size 2 Sensor Kit 3 ft (1.8 m) Schick WiFi S2 Sensor Ship Kit 3 ft B2432103
Size 2 Sensor Kit 18 in (0.5 m) Schick WiFi S2 Sensor Ship Kit 18 in B2432100
Size 2 Sensor System Ship Kit . Schick WiFi S2 Sensor System Ship Kit
US) 18 in (0.5 m) 18 in (US Power Supply) B2432000
Size 2 Se.nsor System Ship Kit 18in (0.5 m) Schmk WiFi SZ Sensor System Ship Kit B2432004
(International) 18 in (International Power Supply)
Schick WiFi USB Interface o Schick WiFi USB Interface B2410100
Assembly Assembly
Schick WiFi Docking Station o Schick WiFi Docking Station B2420100
Assembly Assembly
Schick WiFi Docking Station o Schick WiFi Docking Station B2420110
Power Supply Kit (US) Power Supply Kit (US)
Schick WiFi Docking Station o Schick WiFi Docking Station B2420111

Power Supply Kit

Power Supply Kit
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SENSOR CABLE N PART
ITEM DESCRIPTION
LENGTH NUMBER

(International) (International)
?:zlﬁlcelz WiFi Universal Sensor 6 ft (1.8 m) Schick WiFi Universal Sensor Cables 6 ft B2400168
Schick WiFi Universal Sensor 9 ft (2.7 m) Schick WiFi Universal Sensor Cables 9ft B2400166
Cables
?:zlﬁlcelz WiFi Universal Sensor 3 e (1.8 m) Schick WiFi Universal Sensor Cables 3 ft B2400167
?:zlﬁlcelz WiFi Universal Sensor 18in (0.5 m) Schick WiFi Universal Sensor Cables 18 in B2400165
Schick WiFi Cable Kit 6 ft (1.8 m) Schick WiFi Cable Kit 6 ft B2400121
Schick WiFi Cable Kit 9 ft (2.7 m) Schick WiFi Cable Kit 9 ft B2400122
Schick WiFi Cable Kit 3 £t (0.9 m) Schick WiFi Cable Kit 3 ft B2400123
Schick WiFi Cable Kit 18 in (0.5 m) Schick WiFi Cable Kit 18 in B2400120
USB Cable Kit 16.5 ft (5 m) USB A/B 5M Cable with Ferrite B2250150
USB Cable Kit 6.5 ft (2 m) USB A/B 2M Cable with Ferrite B2250151
USB Cable Kit 1.6 ft (0.5 m) USB A/B 0.5M Cable with Ferrite B2250152
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7.3. Battery Disposal

Lithium-ion batteries are subject to disposal and recycling regulations
that vary by country and region.

For safe disposal of the WiFi system’s rechargeable battery, please
use your local battery recycling facility, return the battery to your
local distributor, or mail directly to:

Sirona Dental, Inc.
30-30 47th Avenue
Long Island City
NY 11101

USA

7.4. Battery Conditions

Indications that a battery is low on power or approaching depletion
will appear in the following ways:

e Schick WiFi Interface LED
(Figure 10. Schick WiFi Interface LED Color Range during
Operation, on page 43 )

e Schick Wik Interface Status battery level
(Section 1.9.1, Wireless Monitor, on page 13).

If the battery is low on power, it may be possible to complete the
current dental exam, but we strongly recommend recharging the
battery by placing it in the Docking Station before the Schick Wil
Interface is used again.

If battery power is approaching depletion, meaning that the device
cannot hold a charge for more than a few X-rays, the battery must be
replaced, as the device will be unable to send images wirelessly.

7.5. Upgrades and Diagnostics

If needed, new firmware for the Schick Sensor and Schick WiFi
Interface may be installed using the Web Server and Upgrade Utility,
as described in Section 5 on page 86.
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7.6. Quality Procedure

7.6.1. Introduction

If you wish to perform an operational check of the system before
using it on a patient, or if your local or state radiation agency requires
you to perform a quality check periodically, then the following
procedure may be used for this purpose. This is only a suggested
method and other means of verifying proper operation may also be
acceptable.

7.6.2. Items Required

The following quality procedure requires a small metal object (such as
an alligator or paper clip) to be used with a Sensor and X-ray source.

7.6.3. Procedure

1. Place the Sensor on a clean, moisture-free surface. The flat side
of the Sensor is the active area; this side should be facing up. The
side where the cable attaches to the Sensor will be facing down,
towards the table surface.

2. Place a small metal object (an alligator clip in this procedure) on
the Sensor and position the X-ray source above it by
approximately 3 inches.

3. To avoid saturating the image with X-rays, set the technique
factors to values that correspond to a typically-used minimum
dosage.

4. Within your Imaging software (CDR DICOM, EFagleSoft,
Patterson Imaging software), create or open an X-ray exam and
click once on any selected target frame. Activate the X-ray source
when the “Ready to acquire image . . . Activate X-ray unit now”
message appears.

NOTE: If AutoTake is enabled, the target frame should NOT be flashing RED
when ready to acquire an X-ray.

5. When the image is displayed, compare it with the samples shown
in Figure 34 on page 120. An ideal image is one with sharp edges,
clearly in focus, and having a distinct contrast between the object
and the area around it. If necessary, adjust the technique factors
and retake the image.

6. Record the results in last page of this document, or in a log book,
and / or save the exam and its image(s) for future reference.
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SATURATED

65 kVp 4mA 0.71s

ACCEPTABLE

65 kVp 4mA 0.32s

UNDEREXPOSED

65 kVp 4mA 0.07s

Figure 34. Comparing Quality Procedure Images
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8. Schick Elite Cable Replacement

NOTE:If you intend to replace the cable for the Schick 33 Sensor,
Pplease skip ahead to the next chapter and follow those instructions.

IMPORTANT! Always disconnect the Schick Elite Sensor from the Schick WiFi Interface
during cable replacement to avoid potential damage to Sensor components. Close CDR
DICOM or any other imaging application (EagleSoft or Patterson Imaging) prior to starting
cable replacement. When performing cable replacement, always work outside the patient
area, using the tools and materials supplied and / or recommended by Sirona Dental.

IMPORTANT! Like other electronic devices, your Schick Elite Sensor is susceptible to
electrostatic discharge (ESD), particularty when the device is used in or around carpeted
areas or low-humidity environments. During cable replacement, when Sensor contacts
are exposed, it is especially important to protect the device from potential ESD damage.
Touching a metal surface prior to replacing the Schick Elite Sensor cable will reduce the
risk of damaging Sensor components by accidental static discharge. The use of anti-static
floor mats or floor treatments (for example Staticide 2005/2002) will also help eliminate
static build-up in your office.

SterP 1

A. Check the Sensor. Schick Elite Sensors
have artwork similar to the graphic shown
here and use accessoties that are BLUE in
colot.

B. If your Sensor is different, stop here and
follow the steps for Schick 33 cable
replacement.
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STEP 2

A. Using a dental instrument, carefully lift

and remove the tab cover from the back
of the Sensor cable.

Dispose of the tab cover as a new one
will be used when the new cable is
attached.

STEP 3

A.

B.

Using the screwdriver provided, loosen
and remove the 2 screws that secure the
cable to the Sensot.

Dispose of the screws as new ones are
supplied. Remove the cable from the
Sensor.

STEP 4

A.

After removing the cable, the area above
the contacts should be completely clear.
Remove the white elastomeric if it
dislodged accidentally from previous
cable.

If the Sensor does not have a blue frame,
remove one from the Schick Elite spare
parts kit and place it into position. When
positioned correctly, the flat side of the
frame will be facing up. (Schick Elite
parts are blue.)

ik

o

(A)

-
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STEPS

Using tweezers, take a new (blue) strip from
the Schick Elite spare parts kit and insert the
strip into its slot in the Sensor. Strip shown
darker in this image for clarity.

STEP 6

After inserting the strip, apply a small amount
of finger pressure to ensure the elastomer is

seated squarely in the slot. : \\‘\\_\\
IMPORTANT! The elastomeric strip must n
be seated squarely in the slot for the /

Sensor to function.

STEP 7

A. Remove cable from kit.

B. Align the cable to the Sensor so the
Sensor keying feature connects to the
corresponding key in the cable. When
propetly aligned, the cable fits the back of
the Sensor evenly and the metal area is
completely covered.
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STEP 8

A. Using the screwdriver, tighten the first
screw just until you feel some resistance.

B. Repeat this action for the second screw.

C. Fully tighten both screws and make sure
that they are securely tightened.

STEP 9

A. Place a new tab cover over the screw slot
and slide it across the slot while applying

downward pressure, especially at the
middle of the tab.

B. When the tab completely covers the slot,
snap it into place.
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9. Schick 33 Cable Replacement

NOTE:If you intend to replace the cable for the Schick Elite Sensor,
Pplease go back to the previous chapter and follow those instructions.

IMPORTANT! Always disconnect the Schick 33 Sensor from the Schick WiFi Interface
during cable replacement to avoid potential damage to Sensor components. Close CDR
DICOM or any other imaging application (EagleSoft or Patterson Imaging) prior to starting
cable replacement. When performing cable replacement, always work outside the patient
area, using the tools and materials supplied and / or recommended by Sirona Dental.

IMPORTANT! Like other electronic devices, your Schick 33 Sensor is susceptible to
electrostatic discharge (ESD), particularty when the device is used in or around carpeted
areas or low-humidity environments. During cable replacement, when Sensor contacts
are exposed, it is especially important to protect the device from potential ESD damage.
Touching a metal surface prior to replacing the Schick 33 Sensor cable will reduce the risk
of damaging Sensor components by accidental static discharge. The use of anti-static
floor mats or floor treatments (for example Staticide 2005/2002) will also help eliminate
static build-up in your office.

STteEP 1

A. Check the Sensor. Schick 33 Sensors have
artwork similar to the graphic shown here
and use accessoties that are RED in colot.

B. If your Sensor is different, stop here and
follow the steps for Schick Elite cable
replacement.
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STEP 2

A. Using a dental instrument, carefully lift
and remove the tab cover from the back
of the Sensor cable.

B. Dispose of the tab cover as a new one
will be used when the new cable is
attached.

STEP 3

A. Using the screwdriver provided, loosen
and remove the 2 screws that secure the
cable to the Sensor.

B. Dispose of the screws as new ones are
supplied. Remove the cable from the
Sensor.

STEP 4

A. Using tweezers, remove the small
elastomeric strip from the Sensor.

Dispose of this strip, as it will be ==
replaced.
B. Take a new (red) strip from the Schick 33 _ i
spare parts kit, holding it in the tweezers o’ ’
P

as shown. (Schick 33 parts are red.)
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STEPS

Insert the strip into its slot in the Sensor. S#ip
shown darker in this image for clarity.

.
o
s

STEP 6

After inserting the strip, apply a small amount
of finger pressure to ensure the elastomer is

seated squarely in the slot. / — -
-

IMPORTANT! The elastomeric strip must i
be seated squarely in the slot for the e
Sensor to function.

STEP 7

A. Remove cable from kit.

B. Align the cable to the Sensor so the
Sensor keying feature connects to the
corresponding key in the cable. When
propetly aligned, the cable fits the back of
the Sensor evenly and the metal area is
completely covered.
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STEP 8

A. Using the screwdriver, tighten the first
screw just until you feel some resistance.

B. Repeat this action for the second screw.

C. Fully tighten both screws and make sure
that they are securely tightened.

STEP 9

A. Place a new tab cover over the screw slot
and slide it across the slot while applying

downward pressure, especially at the
middle of the tab.

B. When the tab completely covers the slot,
snap it into place.
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10. Reference

10.1. System Summary

Table 20. Schick Wiki System Summary

HARDWARRE DESCRIPTION
Schick WiFi Interface
2.4 GHz FM digital data transmission, IEEE 802.11b/g, WiFi-
Description enabled. Effective Radiated Power of <2 mW. Battery pack and
On / Off switch. Multi-color LED
Dimensions 122 x 31 x 24 mm (L x W x H)
Weight 50 g (approx.)
Schick WiFi Docking Station
Recessed configuration cradle with docking connector. Separate
Description LEDs for Schick WiFi Interface connection, USB cable, and AC
power adapter and cord
Input +6.5VDC
Dimensions 103 x 76 x 37 mm (L x W x H)
Weight 50 g (approx.)
100-240 V, 50/60 Hz, 500 mA (input
Power Adapter 6.5V, 1.5 A (output) o)
Schick 33 Sensor
Technology CMOS-APS (Active Pixel Sensor)
Pixel Size 15 pum, image acquisition in 15 um
Line Pairs 28 Ip (33.3 Ip - Nyquist Limiting Frequency)
Size 0 18 x 24 mm
Active Sensor Area Size 1 20 x 30 mm
Size 2 25.6 x 36 mm
Size 0 23.6x31.9 x 7.5 mm
External Dimensions Size 1 254x383x7.5mm
Size2 31.2x43.0x 7.5 mm
Cable Length 2.70 m (maximum)
Schick Elite Sensor
Technology CMOS-APS (Active Pixel Sensor)
Pixel Size 15 pm (native); 30 pm (effective) pixel resolution
Line Pairs 16.7 Ip at 30 pm
Size 0 18 x 24 mm
Active Sensor Area Size 1 20 x 30 mm
Size 2 26 x 36 mm
Size 0 23.5x32x 6.3 mm
External Dimensions Size 1 253 x38.4 x 6.7 mm
Size2 31.2x43.9 x 6.3 mm

Cable Length

2.70 m (maximum)
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Table 21. Wireless Interface Characteristics

PARAMETER DESCRIPTION
Technology IEEE 802.11b/g, WiFi Compliant
Frequency 2.4GHz: Channels 1-13 (2412-2472 MHz) US, Canada, Europe, Japan
2.4GHz: Channel 14 (2484 MHz) Japan only
Modulation Technology | DSSS, CCK, OFDM
Modulation Type DBPSK, DQPSK, CCK, BPSK, QPSK, 16QAM, 64QAM

Network Access Modes

Ad-Hoc and Infrastructure

Wireless Data Rates

802.11b - 11,5.5,2,1 Mbs; 802.11¢ - 54,48,36,24,18,12,9,6 Mbs

Security Protocols

Disabled, WEP 64 and 128 bit, WPA (TKIP), WPA (AES), WPA2
(AES), WPA Enterprise

Table 22. Compliance Specifications

SPECIFICATION DESCRIPTION
CAN/CSA C22.2 . . . .
No.601.1-M90 Medical Electrical Equipment Part 1: General Requirements for Safety

ETSI-EN 301 489-3

Electromagnetic Compatibility and Radio Spectrum Matters (ERM);
Electromagnetic Compatibility (EMC) Standard for Radio Equipment
and Services; Part 1: Common Technical Requirements

IEC60601-1

Medical Electrical Equipment Part 1: General Requirements for Safety

IEC60601-1-2

Medical Electrical Equipment Part 1: General Requitements for Safety
2.Collateral Standard: Electromagnetic Compatibility — Requirements
and Tests

UL60601-1 Medical Electrical Equipment: General Requirements for Safety
Table 23. Environmental Specifications
CATEGORY DESCRIPTION
Classification Class II, Type BF equipment
Not Category AP Equipment
Not Category APG Equipment
Mode of Operation Equipment is intended for continuous use
Additional Equipment is not suitable for use in the presence of a Flammable
Notes Anesthetic Mixture with Air or with Oxygen or Nitrous Oxide.

Transport and Storage
Conditions

Ambient temperature range: -40° F -40° C) to 158° F (-70° C)
Relative humidity range: less than 20 - 85%
Atmospheric pressure range: 500 hPa to 1060 hPa

Operating Conditions

Ambient temperatute range: 50° F (+10° C) to 104° F (-40° C)
Relative humidity range: less than 20 - 85%

Operating
Altitude

<2000 m
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Table 24. Guidance and Manufacturet's Declaration - Electromagnetic Emissions

PLEASE NOTE: Schick Wil'i systems are intended for use in the electromagnetic environment specified
below. Users of these systems must ensure they are used in such an environment.

EMISSIONS TEST COMPLIANCE GUIDANCE

RF emissions Group 1 Schick WiFi systems use RF energy only for

CISPR 11 their internal function. Therefore, its RF
emissions are very low and are not likely to
cause any interference in nearby electronic
equipment.

RF emissions Class B Schick WiFi systems are suitable for use in

CISPR 11 all establishments including domestic

Harmonic emissions Class A establishments and those directly connected

1EC 61000-3-2 to the public low-voltage supply network

Voltage fluctuations/ that supplies buildings used for domestic

flicker emissions Complies purposes.

IEC 61000-3-3
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Table 25. Guidance and Manufacturet's Declaration - Electromagnetic Immunity

PLEASE NOTE: Schick Wil'i systems are intended for use in the electromagnetic environment specified
below. Users of these systems must ensure they are used in such an environment.

discharge (ESD)
IEC 61000-4-2

+4 kV contact 2

IMMUNITY TEST IEC 60601 TEST COMPLIANCE GUIDANCE
LEVEL LEVEL
Electrostatic +6 kV contact +6 kV contact Floors should be wood, concrete

or ceramic tile. If floors are
covered with synthetic material,
the relative humidity should be at

IEC 61000-4-5

mode

+ 2kV common
mode

differential mode

+ 2kV common
mode

8 kV air +8 kV air
least 30%.

Electrical fast 12 kV for power +2 kV for power Mains power quality should be
transient/burst supply lines supply lines that of a typical commercial or
TIEC 610004-4 +1 kV for +1 kV for hospital environment.

input/output lines | input/output

lines

Surge + 1 kV differential | £ 1 kV Mains power quality should be

that of a typical commercial or
hospital environment.

Voltage dips, short
interruptions and
voltage variations
on power supply
input lines

IEC 61000-4-11

< 5% Ur
(>95% dip in UT)
for 0.5 cycle

< 40% Uy
(>60% dip in U'T)
for 5 cycles

< 70% Ur
(>30% dip in U'T
for 25 Cycles

< 5% Ur
(>95% dip in UT)
for 0.5 Cycle

< 40% Ur
>60% dip in U
for 5 cycles

< 70% Ur
(>30% dip in U
for 25 Cycles

Mains power quality should be
that of a typical commercial or
hospital environment. If the user
of the system requires continued
operation during mains
interruptions, it is recommended
that the system be powered from
an uninterruptible power supply
or battery.

NOTE: Uris the ACmains
voltage prior to application of

IEC 61000-4-6

150 kHz to 80
MHz

< 5% Ur < 5% Ur the test level.
(>95% dip in UT) (>95% dip in UT)
for 5 SEC for 5 SEC
Power frequency 3A/m 3A/m
(50/60 Hz)
magnetic field
1EC 61000-4-8
Conducted RF 3 Vrms 3 Vrms Portable and mobile RF

communication equipment
should be used no closer to any
part of the system, including its
cables, than the recommended
separation distance calculated
from the equation applicable to
the frequency of the transmitter.
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IMMUNITY TEST IEC 60601 TEST COMPLIANCE GUIDANCE
LEVEL LEVEL
Recommended sepatration
distance:
d=(3.5/3)x\P
Radiated RF 3V/m 3V/m d=(3.5/3)xVP for 80 MHz to
IEC 61000-4-3 80 MHz to 2.5 800Mhz

GHz

d=(7/3)x\P for 800 MHz to
2.5Ghz

Where P is the maximum output
rating of the transmitter in watts
(W) according to the transmitter
manufacturer and d is the
recommended separation in
meters (m).

Field strengths from fixed RF
transmitters, as determined by an
electromagnetic site survey,
should be less than the
compliance level in each
frequency range. ¢

Interference may occur in the
vicinity of equipment marked
with the following symbol.

()

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and
reflection from structures, objects and people

2 To avoid damage to electronic components inside, users should not touch the exposed contacts on the Wireless Sensor
and the USB Interface before discharging to an earthed object.

® Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To
assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be
considered. If the measured field strength in the location in which the system is used exceeds the applicable RF
compliance above, the system should be observed to verify normal operation. If abnormal performance is observed,
additional measures may be necessary, such as reorienting or relocating the system.

¢ Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Table 26. Recommended Separation Distance between Portable and Mobile REF Communications
Equipment and the System

PLEASE NOTE: Schick WiEi systems are intended for use in the electromagnetic environment specified
below. Users of these systens should ensure they are used in such an environment.

RATED MAXIMUM OUTPUT SEPARATION DISTANCE ACCORDING TO THE
POWER OF THE TRANSMITTER FREQUENCY OF THE TRANSMITTER
) (M)

150 kHz to 800 MHz 800 MHz to 2.5 GHz
d=1.17x\P d=3.3x\P

0.01 0.17 0.33

0.1 0.37 1.04

1 1.17 3.30

10 3.69 10.44

100 117 33.00

For transmitters rated at a maximum output power not listed above, the recommended separation
distance d in meters (m) can be estimated using the equation applicable to the frequency of the
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according

to the transmitter manufacturer.

NOTE 1: At 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected
by absorption and reflection from structures, objects, and people
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Appendix A. Battery Safety Information

and Replacement

You must read these safety instructions and warnings before using or
charging the battery inside the Schick Wili Interface.

Lithium ion batteries are volatile. Failure to read and follow these
instructions may result in fire, personal injury, and damage to
property, if charged or used impropetly.

A-1. General Guidelines and Warnings

Batteries are not fully charged when received. They contain
approximately 50% of a full charge.

Use only the Docking Station supplied with the Schick Wili system
to charge the Schick WiFi Interface. Do not use any other charging
device, particularly NiCd or NiMh chargers, as they may cause the
battery to overheat and cause a fire, which may result in personal
injury and property damage.

If at any time a battery begins to swell or deform, discontinue use of
that battery immediately and contact your local distributor of Sirona
Dental products for further information.

A-2. Docking Process

For proper battery charging, the operating temperature should be
between 32° F or 0° C (min) and 113° F or 45° C (max).

When the battery is charging, make sure that no flammable materials
are nearby. If warm to the touch, allow the battery cool down to
ambient temperature before charging.

A-3. Storage and Transportation

Store batteries at a room temperature between 40° F (4° C) and 70° F
(21° C). For best results, do not expose battery packs to direct
sunlight (heat) for extended periods. Never store a battery where the
temperature can exceed 120° F (49° C).

Storing batteries at temperatures higher than 170 degrees F (66° C)
for extended periods of time (more than 2 hours) may damage them
and cause a fire.
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If transporting or storing the battery temporarily, temperatures
should be higher than 20° F (-7° C), but less than 150° F (66° C). Do
not handle batteries when temperatures exceed 160° F (66° C).

A-4. Battery Life

Batteries that lose 20% of their capacity must be removed from
service and disposed of properly. If the battery is unable to sustain
the operation of the Schick Wil Interface except by frequent re-
charging, please contact your local distributor of Sirona Dental
products for further information.

The battery product warranty does not cover collateral damage,
misuse, abuse, incorrect charging, or other inappropriate use of this
product.

A-5. Battery Replacement

IMPORTANT! Be sure to follow the steps for proper battery replacement. Do
not short-circuit, disassemble, or modify the battety. Do not place it near high-
temperature locations. Do not place in fire or apply heat to it. Do not subject the
battery to strong impacts or shocks. Do not expose the battety to water or allow it
to get wet.
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STteEP 1

A. Turn off the Schick WiFi Interface if it is
currently on.

B. Locate the screw that secures the battery
cover. This screw is at one end of the
Schick WiFi Interface, farthest from the
LED.

C. Using the screwdriver supplied, untighten
and remove the screw that secures the
battery cover.

D. Retain the battery cover screw.

STEP 2

A. Lift the battery cover to remove it.

B. Retain the battery cover.

STEP 3

A. Locate the connector that attaches the
battery to the Schick WiFi Interface.

B. Disconnect the connector from its socket

and remove the battery. & IS
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STEP 4

A. When the battery is removed, you should
see two small rubber pads in the
compartment: one on each side of the
connector socket.

B. Using the screwdriver supplied, pry both
pads from the base of the battery
compartment. The pads are secured by
light adhesive only, so unseating them
should require little effort.

C. Dispose of the pads as they are no longer
needed.

STEPS

A. Insert the new battery (7 should say Sirona
on the label), carefully connecting the
connector to the socket. Both items key
to each other and attach easily when
inserted correctly.

B. Insert the battery cover removed
previously, sliding the prong on the cover
(circled, shown in image on next page)
into the opening at the end of the
compartment.

C. Snap the cover into place to close the
compartment.
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STEP 6

Insert the battery cover screw removed
previously. Using the screwdriver, tighten the
screw until you feel some resistance.
Continue tightening until the screw is fully

seated.

STEP 7

A. To ensure that the battery level of your
new Sirona battery is reported accurately,
please perform the following steps:

Click on the Wireless Monitor in
the System Tray and select Wil
Interface Management.

Select the Schick WiFi Interface
and make sure it is unpaired.

Click File > Open Selected
Device Web Interface.

Click on the Settings tab and
select “Sirona” from the Wili
Interface Battery menu.

Click Save.

B. Dispose of the replaced battery propetly,
according to local regulations. If no
suitable disposal facility is available, please
return the battery to Sirona.

WiFi Interface Battery:

Schick [~]

Schick
Sirona
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A-6. List of Materials

The following is a list of materials supplied with the battery
replacement kit.

PART NUMBER DESCRIPTION QUANTITY
B2410220 Replacement, Wil'i Interface Battery Pack 1
B1207041 Screwdriver, PHO 1

A-7. For More Information . . .

In the United States, customers can contact the Patterson
Technology Center at 877-498-6505. Outside the United States,
please contact the authorized dealer for Sirona Dental products in
your country or region.

If you are returning the battery to us, please use the following
address:

Sirona Dental, Inc.
30-30 47" Avenue
Long Island City
NY 11101

USA
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.
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Image Quality Inspection

The following table may be used to record the results of a quality check. For details on how to perform this procedure,
please refer to Section 7.6, Quality Procedure, on page 119.

INSPECTION IMAGE QUALITY

Year Date Name Signature Acceptable Not Acceptable
0 *
D *
D *
0 *
0 *
0 *
D *
D *
D *
0 *

O|o|o|o|ojo|g|ojojc

* In the event that image quality is unacceptable, please contact the authorized dealer for Sirona Dental products in your
country or region. In the United States, customers can contact the Patterson Technology Center at 877-498-6505.
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